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   Objectives 
 After completing this lab, you will know how to: 

  ●  1   Use a template to create a presentation.  

  ●  2   View and edit a presentation.  

  ●  3   Copy and move selections.  

  ●  4   Move, copy, and delete slides.  

  ●  5   Move, demote, and promote items.  

  ●  6   Use a numbered list.  

  ●  7   Check spelling.  

  ●  8   Size and move placeholders.  

  ●  9   Change fonts and formatting.  

  ●  10   Insert and modify clip art.  

  ●  11   Run a slide show.  

  ●  12   Document a file.  

  ●  14   Preview and print a presentation.   

  Lab 1  Creating a Presentation 
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      You are the volunteer coordinator at the local Animal 

Rescue Foundation. This nonprofit organization res-

cues unwanted pets from local animal shelters and 

finds foster homes for them until a suitable adoptive 

family can be found. The agency has a large volunteer 

group called the Animal Angels that provides much-

needed support for the foundation. 

 The agency director has decided to launch a cam-

paign to increase community awareness about the 

foundation. As part 

of the promotion, you 

have been asked to 

create a powerful and 

persuasive presenta-

tion to entice more 

members of the com-

munity to join Animal 

Angels. 

 The agency director has asked you to preview the 

presentation at the weekly staff meeting tomorrow 

and has asked you to present a draft of the presenta-

tion by noon today. 

 To help you create the presentation, you will 

use Microsoft PowerPoint 2010, a graphics pre-

sentation application that is designed to create pre-

sentation materials such as slides, overheads, and 

handouts. Using PowerPoint 2010, you can create a 

high-quality and inter-

esting onscreen pre-

sentation with pizzazz 

that will dazzle your 

audience.        

  

 Animal Rescue Foundation 

   CASE STUDY 
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        Each main topic in your 

presentation should have a 

supporting slide with a title and 

bulleted points.  

    The presentation can be 

reorganized easily by adding, 

deleting, and moving slides.  

    Enhance the presentation 

with the addition of graphics 

and text colors.  
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PP1.4 Lab 1: Creating a Presentation

  The following concepts will be introduced in this lab: 

1 Slide A slide is an individual “page” of your presentation.

2 Spelling Checker The spelling checker locates all misspelled words, duplicate words, 
and capitalization irregularities as you create and edit a presentation, and proposes pos-
sible corrections.

3 AutoCorrect The AutoCorrect feature makes some basic assumptions about the text you 
are typing and, based on those assumptions, automatically corrects the entry.

4 Layout A layout defines the position and format for objects and text on a slide. A layout 
contains placeholders for the different items such as bulleted text, titles, charts, and 
so on.

5 Graphic A graphic is a nontext element or object such as a drawing or picture that can 

be added to a slide.   

Concept Preview 

   Starting a New Presentation 

  The Animal Rescue Foundation has just installed the latest version of the 
Microsoft Office suite of applications, Office 2010, on its computers. You will 
use the graphics presentation program, Microsoft PowerPoint 2010, included 
in the Office suite, to create your presentation. Using this program, you 
should have no problem creating the presentation in time for tomorrow’s staff 
meeting.  

   DEVELOPING A PRESENTATION 

 During your presentation, you will present information about the Animal Res-
cue Foundation and why someone should want to join the Animal Angels vol-
unteer group. As you prepare to create a new presentation, you should follow 
several basic steps: plan, create, edit, enhance, and rehearse. 

Step Description

Plan The first step in planning a presentation is to understand its purpose. You also need to find 
out the length of time you have to speak, who the audience is, what type of room you will be 
in, and what kind of audiovisual equipment is available. These factors help to determine the 
type of presentation you will create.

Create To begin creating your presentation, develop the content by typing your thoughts or notes 
into an outline. Each main idea in your presentation should have a supporting slide with a 
title and bulleted points.

Edit While typing, you will probably make typing and spelling errors that need to be corrected. 
This is one type of editing. Another type is to revise the content of what you have entered to 
make it clearer, or to add or delete information. To do this, you might insert a slide, add or 
delete bulleted items, or move text to another location.

Enhance You want to develop a presentation that grabs and holds the audience’s attention. Choose a 
design that gives your presentation some dazzle. Wherever possible, add graphics to replace 
or enhance text. Add effects that control how a slide appears and disappears and that reveal 
text in a bulleted list one bullet at a time.

Rehearse Finally, you should rehearse the delivery of your presentation. For a professional presenta-
tion, your delivery should be as polished as your materials. Use the same equipment that you 
will use when you give the presentation. Practice advancing from slide to slide and then back 
in case someone asks a question. If you have a mouse available, practice pointing or drawing 
on the slide to call attention to key points.
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       •   Start the PowerPoint 

2010 application.   

    •   If necessary, 

maximize the 

window.    

  Your screen should be similar to  

  Figure 1.1   

  Having Trouble? 

 See “Common Office 2010 Interface 
Features,” page IO.14, for information 
on how to start the application and use 
features that are common to all 2010 
Office applications.  

  Additional Information 

 Because the Office 2010 applications 
remember settings that were on when 
the program was last exited, your 
screen may look slightly different.  

 Starting a New Presentation PP1.5

 After rehearsing your presentation, you may find that you want to go back to 
the editing phase. You may change text, move bullets, or insert a new slide. 
Periodically, as you make changes, rehearse the presentation again to see how 
the changes affect your presentation. By the day of the presentation, you will 
be confident about your message and at ease with the materials.  

  EXPLORING THE POWERPOINT DOCUMENT WINDOW 

 During the planning phase, you have spoken with the foundation director 
regarding the purpose of the presentation and the content in general. The 
purpose of your presentation is to educate members of the community about 
the organization and to persuade many to volunteer. In addition, you want to 
impress the director by creating a professional presentation.       

Slides tab displays 

slide thumbnails

Status bar 

Notes pane
View buttons  

Slide Indicator

Blank presentation file 

consisting of a single slide 

opens in Normal view

Selected slide

displayed in

Slide pane

Outline tab displays text 

content of each slide

Reading view Slide Show 

view

Normal view 

is selected

Slide Sorter 

view

  Figure 1.1    

 When you first start PowerPoint, a new blank presentation file, named Pre-
sentation1, is opened and displayed in the    document window.    It is like a blank 
piece of paper that already has many predefined settings. These default set-
tings are generally the most commonly used settings and are stored in the 
Blank Presentation template file. 

 Many other templates that are designed to help you create professional-
looking presentations are also available within PowerPoint and from the 
Microsoft Office Online Web site. They include design templates, which pro-
vide a design concept, fonts, and color scheme; and content templates, which 
suggest content for your presentation based on the type of presentation you 
are making. You also can design and save your own presentation templates. 
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PP1.6 Lab 1: Creating a Presentation

 The Blank Presentation template consists of a single slide that is displayed 
in the document window. 

 A    slide    is an individual “page” of your presentation. The first slide of a presentation is the title slide, which is 
used to introduce your presentation. Additional slides are used to support each main point in your presenta-
tion. The slides give the audience a visual summary of the words you speak, which helps them understand the 
content and keeps them engaged. The slides also help you, the speaker, organize your thoughts and prompt you 
during the presentation.  

1  Concept  Slide 

 When you first start PowerPoint, it opens in a view called Normal view. A    view    
is a way of looking at a presentation and provides the means to interact with 
the presentation. PowerPoint provides several views you can use to look at and 
modify your presentation. Depending on what you are doing, one view may be 
preferable to another. 

View Button Description

Normal Provides four working areas of the window that allow you to work on all aspects 
of your presentation in one place.

Slide Sorter Displays a miniature of each slide to make it easy to reorder slides, add special 
effects such as transitions, and set timing between slides.

Reading View
Displays each slide in final form within the PowerPoint window so you can 
see how it will look during a presentation but still have access to the Windows 
desktop.

Slide Show Displays each slide in final form using the full screen space so you can practice or 
present the presentation.

 Normal view is displayed by default because it is the main view you use 
while creating a presentation. Normal view has four working areas: Outline 
tab, Slides tab, Slide pane, and Notes pane. These areas allow you to work 
on all components of your presentation in one convenient location. The 
   Outline tab    displays the text content of each slide in outline format, and 
the    Slides tab    displays a miniature version or    thumbnail    of each slide. 
You can switch between the Slides and Outline tabs by clicking on the tab. 
The    Slide pane    displays the selected slide. The    Notes pane    includes space 
for you to enter notes that apply to the current slide. 

 Below the document window is the status bar, which displays the slide 
indicator, messages and information about various PowerPoint settings, but-
tons to change the document view, and a window zoom feature. The    slide 
indicator    identifies the number of the slide that is displayed in the Slide 
pane, along with the total number of slides in the presentation. You will 
learn about the other features of the status bar shortly. 

 You decide to try to create your first presentation using the Blank Presenta-
tion template. It is the simplest and most generic of the templates. Because it 
has minimal design elements, it is good to use when you first start working 
with PowerPoint, as it allows you to easily add your own content and design 
changes. 
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       •   Click the “Click to 

add title” placeholder.    

  Your screen should be similar to  

  Figure 1.2   

  Additional Information 

 A solid border indicates that you can 
format the placeholder box itself. 
Clicking the dashed-line border changes 
it to a solid border.  

  Having Trouble? 

 See the section “Entering and Editing 
Text” in the Introduction to Microsoft 
Office 2010 to review this feature.  

 Starting a New Presentation PP1.7

 Notice the slide contains two boxes with dotted borders. These boxes, called 
  placeholders,    are containers for all the content that appears on a slide. Slide 
content consists of text and objects such as, graphics, tables and charts   .    In 
this case, the placeholders are text placeholders that are designed to contain 
text and display standard    placeholder text    messages that prompt the user to 
enter a title and subtitle.  

  ENTERING AND EDITING TEXT 

 As suggested, you will enter the title for the presentation. As soon as you click 
on the placeholder, the placeholder text will disappear and will be replaced by 
the text you want to appear in the slide.     

Placeholder 

selected and ready

for entry of text

Mouse pointer

Placeholder text

Placeholders

  Figure 1.2    

  Notice that the placeholder is surrounded with a dashed-line border. This indi-
cates that you can enter, delete, select, and format the object inside the place-
holder. Because this placeholder contains text, the cursor is displayed to show 
your location in the text and to allow you to select and edit the text. Addition-
ally, the mouse pointer appears as a    to be used to position the cursor.       

Next you will type the title text you want to appear on the slide. Then you 
will enter the subtitle.       
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       •   Type   Join 
Animal Angels

     •   Click in the “Click 

to add subtitle” 

placeholder and type  

Animal Rescue 
Foundation

  Your screen should be similar to  

Figure 1.3   

  Having Trouble? 

 If you make a typing error, press 
B  to delete the characters 
back to the error and retype the entry.  

1

       •   If necessary, click the 

Home tab to open it.   

    •   Click      in the 

Slides group.    

  Your screen should be similar to  

  Figure 1.4   

  Another Method 

 You also can use the keyboard shortcut 
 c   +  M to insert a new slide.  

PP1.8 Lab 1: Creating a Presentation

Thumbnail displays slide 

content

Title and subtitle 

text entered

  Figure 1.3    

 The content for the first slide is complete. Notice that the thumbnail of the 
slide in the Slides tab now displays the text you just entered.  

  INSERTING A SLIDE 

 Next you want to add the content for a second slide. To continue creating the 
presentation, you need to add another slide.       

Inserts new blank slide

Title

placeholder

Content 

placeholder

New slide 

thumbnail is 

highlighted, indicating 

it is the current slide

Total number of

slides in presentation

  Figure 1.4    
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       •   Open the File tab and 

click .   

    •   Click    .  

    •   Open the File tab and 

choose New.    

  Your screen should be similar to  

  Figure 1.5   

  Having Trouble? 

 To complete steps 2 and 3 you need 
an Internet connection. If you are not 
connected to the Internet, choose New 
from Existing, change to the location 
containing your data files, and double-
click on the file pp01_Training. Then 
skip to the next section, Viewing the 
Presentation.  

 Starting a New Presentation PP1.9

 A new slide with a slide title placeholder and a content placeholder was added 
to the presentation. It is displayed in the Slide pane and is the    current slide,
or the slide that will be affected by any changes you make. The Slides tab dis-
plays a second slide thumbnail. It is highlighted, further indicating it is the 
current slide. The status bar displays the number of the current slide and the 
total number of slides in the presentation. 

 Now you could add text to the new slide and continue adding slides to cre-
ate the presentation.  

  OPENING A PRESENTATION TEMPLATE 

 Although the Blank presentation template is opened automatically when you 
start PowerPoint, it is not the only method that can be used to create a presen-
tation. Another is to use one of the many supplied design templates. A third is 
to save the design elements of an existing presentation as a custom template, 
which you would then use as the basis for your new presentation. Finally, 
you can open an existing presentation and modify the design and content as 
needed for the new presentation. 

 Because you have not decided exactly what content should be presented 
next in the presentation, you decide that it might be easier to use one of the 
templates that will suggest the content to include. You will close this file with-
out saving it and then open a presentation template file. 

Blank presentation 

selected

Six methods to create a 

new presentation from files

on your computer

Preview area 

displays first page of 

selected template

Template categories 

provide access to 

presentation template files

on the Office.com Web site

  Figure 1.5    

 The Available Templates and Themes window of Backstage view is open. The 
upper section of this window displays six options from which you can choose to 
start a new presentation from files that are stored on your computer. The Blank 
presentation template is selected, as this is the default template that is opened 
when you first start PowerPoint. The five other choices provide the means of 
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Additional Information

The template categories and files may 
vary as the content from the Office.com 
Web site is updated frequently.

PP1.10 Lab 1: Creating a Presentation

starting a presentation from recent templates you have opened, templates you 
have created, or other existing presentations. 

 The lower section of the window displays categories of templates that are 
available online from Microsoft. When you choose a category, folders of addi-
tional subcategories are displayed that contain the available presentation tem-
plate files. For this presentation, you want to look at the online templates.       

Preview of selected 

template

Thumbnails represent 

available templates

Selected template

  Figure 1.6  

 Thumbnail images representing the first slide in each template file are dis-
played in alphabetical order by name. The preview area displays a larger 
image of the selected thumbnail and information about the template. 

 You think the design of the selected template looks good and decide to 
begin your presentation for the volunteers using the content in this template 
as a guide.       

2

       •   Choose Presentations 

from the    Office.com   

 Templates category.   

    •   Choose the Training 

folder.   

    •   Scroll the list of 

template files 

in the Training 

folder and select 

“Employee Training 

Presentation”.    

  Your screen should be similar to  

  Figure 1.6   
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       •   Click     .   

    •   If necessary, close 

the Help window.    

  Your screen should be similar to  

  Figure 1.7   

  Another Method 

 You also can double-click on the 
thumbnail to download the template file.  

 Starting a New Presentation PP1.11

Moves up or 

down slide

by slide

Click thumbnail 

to make slide 

current

Presentation 

contains nine 

slides

Default filename for 

second new presentation

  Figure 1.7    

 The template file is downloaded and opened in PowerPoint. It contains a total 
of nine slides. Because this is the second new presentation you have worked 
on since starting PowerPoint 2010, the default file name is Presentation2.  

  MOVING AMONG SLIDES 

 You want to look at the slides in the presentation to get a quick idea of their 
content. There are many ways to move from slide to slide in PowerPoint. Most 
often, the quickest method is to click on the slide thumbnail in the Slides tab. 
Clicking on a slide in the Slides tab displays it in the Slide pane and makes 
it the current slide. However, if your hands are already on the keyboard, you 
may want to use the keyboard directional keys. The following table shows 
both keyboard and mouse methods to move among slides in Normal view. 
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To Display Action

Previous slide
Click 

Click above scroll box

Press U

W One slide up

Next slide Click 

Click below scroll box

Press Y

Z One slide down

Any slide Drag the Slide pane’s scroll box until the ScreenTip displays the slide you 
want to view.

Last slide in presentation j

First slide in presentation h

 You will try out several of these methods as you look at the slides in the pre-
sentation. First you will use the Slides tab. This tab makes it easy to move 
from one slide to another. You also will increase the width of the Slide tab 
pane to make the slide thumbnails larger and easier to see. 

      

Drag splitter bar to 

adjust size of panes

Slide contains two

placeholder areas;

title and content

Current slide

  Figure 1.8 

 Slide 4 is the current slide and is displayed in the Slide pane. This slide con-
tains two placeholders: title and content. The content placeholder consists of 
two bulleted items as well as a graphic. Next you will use the Slide pane scroll 
bar to display the next few slides. 

1

       •   Point to the splitter 

bar between the Slide 

pane and the Slides 

tab pane and when 

the mouse pointer 

is shaped as     

 drag to the right to 

increase the width 

of the pane as in  

  Figure 1.8.    

    •   Press   Z   or  

 Y   to move 

to the next slide.   

    •   Scroll the Slides tab to 

display slides 4 to 7.   

    •   Click on slide 4.    

 Your screen should be similar to  

Figure 1.8

ScreenTip

Scroll box
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       •   Click      Next Slide to 

display slide 5.    

     •   Drag the scroll box 

and stop when the 

ScreenTip displays 

Slide 6 of 9.   

    •   Click below the scroll 

box to display slide 7.   

    •   Press   j   to display 

the last slide.    

 Your screen should be similar to  

Figure 1.9

  Having Trouble? 

 The    Previous Slide and    Next 

Slide buttons are located at the bottom 
of the Slide pane’s vertical scroll bar.  

 Editing a Presentation PP1.13

Last slide in 

presentation

Drag scroll box 

to move to slide

Displays next slide

  Figure 1.9 

 You can see this template will help you to create your presentation because the 
content provides some basic guidance as to how to organize a presentation.    

  Editing a Presentation 

  Now you need to edit the presentation to replace the sample content with the 
appropriate information for your presentation. Editing involves making text 
changes and additions to the content of your presentation. It also includes 
making changes to the organization of content. This can be accomplished 
quickly by rearranging the order of bulleted items on slides as well as the 
order of slides.  

   USING THE OUTLINE TAB 

 You have already entered text in a slide in the Slide pane. Another way to make 
text-editing changes is to use the Outline tab in Normal view. The Outline tab 
displays the content of the presentation in outline form, making it easy to see 
the organization of your presentation as you enter and edit content. The first 
change you want to make is to enter a title for the presentation on slide 1. 
First, you will open the Outline tab and select the sample title text on the slide 
and delete it. 
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1

       •   Click the Outline tab 

to open it.   

    •   Scroll the Outline tab 

to the top to display 

the text for slide 1.   

    •   Click anywhere on 

the text for slide 1 

in the Outline tab to 

make it the current 

slide.   

    •   Select the text 

“Training 

Presentation”.   

    •   Press   D .   

 Your screen should be similar to  

Figure 1.10

  Having Trouble? 

 Refer to the topic “Selecting Text” in the 
Introduction to Microsoft Office 2010 to 
review these features.  

PP1.14 Lab 1: Creating a Presentation

Click tab to open it

Sample text deleted 

and placeholder text 

displayed

  Figure 1.10 

 The sample text is deleted. As you change the text content in the Outline tab, it 
also appears in the slide displayed in the Slide pane. Notice that although you 
deleted the sample text, the slide still displays the title placeholder text. 

You will enter the title and subtitle for the presentation next.
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 Additional Information 

If you click the slide icon to the right of 
the slide number in the Outline tab, all 
text on the slide is selected.

2

       •   Type   Join 
Animal Angels    

     •   Select the text 

“Working Efficiently 

and Accurately” 

on the second line 

of slide 1 in the 

Outline tab and type  

 Animal Rescue 
Foundation    

 Your screen should be similar to  

Figure 1.11

  Having Trouble? 

 If you make a typing error, use 
B  or  D  to correct the 
errors.  

 Editing a Presentation PP1.15

Text entered in the Outline 

tab appears on the slide

Slide title

Slide subtitle

  Figure 1.11    

 As soon as you pressed a key, the selected text was deleted and replaced with 
the text you typed. When entering the title for a slide, it is a common practice 
to use title case, in which the first letter of most words is capitalized.       

 The next change you want to make is in the Introduction slide. The sample 
text recommends that you define the subject of the presentation and what the 
audience will learn. You will replace the sample text next to the first bullet 
with the text for your slide. In the Outline tab, you can select an entire para-
graph and all subparagraphs by pointing to the left of the line and clicking 

when the mouse pointer is a   . 
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3

       •   Click on the first 

bullet of slide 2 in the 

Outline tab when the 

mouse pointer is a  

  .   

     •   Type   Your Name, 
Volunter   (this 

word is intentionally 

misspelled)  

Coordinator    

 Your screen should be similar to  

Figure 1.12

  Having Trouble? 

 If you accidentally drag selected text, 
it will move. To return it to its original 
location, immediately click    Undo 
on the Quick Access Toolbar.  

  Having Trouble? 

 Do not be concerned if the spelling 
checker identifies your name as 
misspelled.   

Having Trouble

If the Spelling indicator is not displayed, 
right click on the status bar and choose 
Spell Check from the context menu.

PP1.16 Lab 1: Creating a Presentation

Spelling error identified 

with a wavy red line

Indicates document 

contains a spelling error

  Figure 1.12

     The sample text has been replaced with the text you typed. Depending on the 
length of your name, the text in this bullet may not have wrapped to a second 
line.

CORRECTING ERRORS 

 As you enter text, the program checks each word for accuracy. In this case, a 
spelling error was located. PowerPoint identified the word as misspelled by 
underlining it with a wavy red line. The Spelling indicator    in the status 
bar also shows a spelling error has been detected in the document. 

 The    spelling checker    locates all misspelled words, duplicate words, and capitalization irregularities as you cre-
ate and edit a presentation, and proposes possible corrections. This feature works by comparing each word to a 
dictionary of words. If the word does not appear in the main dictionary or in a custom dictionary, it is identified 
as misspelled. The    main dictionary    is supplied with the program; a    custom dictionary    is one you can create 
to hold words you commonly use, such as proper names and technical terms, that are not included in the main 
dictionary. 

 If the word does not appear in either dictionary, the program identifies it as misspelled by displaying a red 
wavy line below the word. You can then correct the misspelled word by editing it. Alternatively, you can display 
a list of suggested spelling corrections for that word and select the correct spelling from the list to replace the 
misspelled word in the presentation.  

2  Concept   Spelling Checker 
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 Additional Information 

Sometimes the spelling checker cannot 
suggest replacements because it cannot 
locate any words in its dictionary that 
are similar in spelling. Other times the 
suggestions offered are not correct. If 
either situation happens, you must edit 
the word manually.

 Additional Information 

The spelling checker works just as it 
does in the other Microsoft Office 2010 
applications. 

 Editing a Presentation PP1.17

 To quickly correct the misspelled word, you can select the correct spelling 
from a list of suggested spelling corrections displayed on the shortcut menu. 

Suggested correct 

spellings displayed

Shortcut menu 

appears

  Figure 1.13        

 The shortcut menu displays two suggested correct spellings. The menu also 
includes several related menu options described below. 

Option Effect

Ignore All Instructs PowerPoint to ignore the misspelling of this word throughout the rest of this 
session.

Add to Dictionary Adds the word to the custom dictionary list. When a word is added to the custom dic-
tionary, PowerPoint will always accept that spelling as correct.

Spelling Opens the Spelling dialog box to check the entire presentation.

 You will replace the word with the correct spelling and then enter the informa-
tion for the second bullet. 

1

       •   Right-click on the 

misspelled word in 

the Outline tab to 

display the shortcut 

menu.    

  Your screen should be similar to  

  Figure 1.13   
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  Additional Information 

 Bulleted items in a presentation are 
capitalized in sentence case format. 
Ending periods, however, are not 
included.  

PP1.18 Lab 1: Creating a Presentation

Spelling error 

automatically corrected

Indicates no spelling 

errors in document

First letter automatically 

capitalized

  Figure 1.14    

 Notice that the first letter of “volunteer” was automatically capitalized. Also 
notice that the incorrect spelling of the word “oppotunities” was corrected. 
These corrections are part of the AutoCorrect feature of PowerPoint.      

2

       •   Choose “Volunteer” 

from the shortcut 

menu.   

    •   In the Outline tab, 

select the text in 

the second bullet on 

slide 2 by clicking the 

bullet.   

    •   Press  D .   

    •   In the Outline tab, 

select the text in 

the second bullet on 

slide 2.   

    •   Type   volunteer 
oppotunities  

 (this word is 

intentionally 

misspelled) and press 

 z .    

  Your screen should be similar to  

  Figure 1.14   

 The    AutoCorrect    feature makes some basic assumptions about the text you are typing and, based on those 
assumptions, automatically corrects the entry. The AutoCorrect feature automatically inserts proper capitalization 
at the beginning of sentences and in the names of days of the week. It also will change to lowercase letters any 
words that were incorrectly capitalized due to the accidental use of the  l  key. In addition, it also cor-
rects many common typing and spelling errors automatically. 

 One way the program makes corrections automatically is by looking for certain types of errors. For example, 
if two capital letters appear at the beginning of a word, the second capital letter is changed to a lowercase let-
ter. If a lowercase letter appears at the beginning of a sentence, the first letter of the first word is capitalized. If 
the name of a day begins with a lowercase letter, the first letter is capitalized. 

Another way the program makes corrections is by automatically replacing a misspelled word with the correct 
spelling in situations where the spelling checker offers only one suggested spelling correction. AutoCorrect also 
checks all words against the AutoCorrect list, a built-in list of words that are commonly spelled or typed incorrectly. If 
it finds the entry on the list, the program automatically replaces the error with the correction. For example, the typing 
error “aboutthe” is automatically changed to “about the” because the error is on the AutoCorrect list. You also can 
add words to the AutoCorrect list that you want to be corrected automatically. Any such words are added to the list 
on the computer you are using and will be available to anyone who uses the machine after you.

3 Concept   AutoCorrect 
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1

       •   Move to slide 3.   

    •   In the Outline tab, 

replace the sample 

title, Agenda, with  

 Topics of 
Discussion   

    •   Select and replace 

the text in the 

first bullet with  

 Why are pets 
abandoned?   

    •   Select and replace 

the text in the second 

bullet with   How 
can you help?   

    •   Press  e .        

 Your screen should be similar to  

Figure 1.15

 Having Trouble? 

If you accidentally insert an extra bullet 
and blank line, press  B  twice 
to remove them.

  Having Trouble? 

 Refer to “Copying and Moving Selections” 
in the Introduction to Microsoft Office 
2010 to review this feature.  

 Editing a Presentation PP1.19

  COPYING AND MOVING SELECTIONS 

 You are now ready to enter the text for the next slide in your presentation by 
entering the three main topics of discussion. You want to enter a new slide 
title, Topics of Discussion, with three bulleted items describing the topics to 
be discussed. Two placeholder bullets with sample text are displayed. You will 
edit these and then add a third bulleted item. 

Title and bullet 

placeholder text replaced

New bulleted line created

  Figure 1.15    

 A new bulleted line is automatically created whenever you press  e  at the 
end of a bulleted item. Because the text you want to enter for this bullet is 
similar to the text in the second bullet, you decide to save time by copying and 
pasting the bullet text. Then you will modify the text in the third bullet. 
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2

       •   Select the second 

bulleted item.   

    •   Click      Copy in 

the Clipboard group 

of the Home tab.   

    •   Click on the third 

bullet line and 

click    .   

     •   Select “can you” in 

the third bullet item.   

    •   Type   does the 
Foundation   

    •   If necessary, delete 

the fourth blank 

bullet line.    

 Your screen should be similar to  

Figure 1.16

  Another Method 

 You also can press  c   +  C to copy 
a selection and  c   +  V to paste a 
selection.  

PP1.20 Lab 1: Creating a Presentation

Pastes copied 

content

Second bulleted item 

copied and edited

Copies selection

  Figure 1.16    

 The text you copied to the third bullet has been quickly modified. Copying is 
especially helpful when the entries are long and complicated. 

 As you review what you have entered so far in your presentation, you decide 
that it would be better to introduce yourself on the first slide. Rather than 
retyping this information, you will move your introduction from slide 2 to 
slide 1. You will do this using drag and drop. 
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3

       •   In the Outline tab, 

press  e  at the 

end of the subtitle 

in slide 1 to create a 

blank line.   

    •   Select the first 

bulleted item on 

aslide 2.   

    •   Drag the selection 

to the blank line on 

slide 1.   

    •   Move to the blank line 

at the end of slide 1 

and press  B  

to delete it.    

 Your screen should be similar to  

Figure 1.17

  Another Method 

 You can also use    Cut or  

c   +  X to cut a selection and then 

paste it to the new location.  

  Additional Information 

 You can also delete and move slides 
in the Outline tab by clicking on the 
slide icon next to the slide number to 
select the entire slide and then use the 
appropriate command.  

 Editing a Presentation PP1.21

Introduction moved 

from slide 2 to slide 1 

using drag and drop

  Figure 1.17    

 Because the Outline tab lets you see the content in multiple slides at once, it 
makes it easy to see the organization of the presentation and to quickly make 
text changes within and between slides.  

  MOVING, COPYING, AND DELETING SLIDES 

 As you continue to plan the presentation content and organization, you decide 
you will not use the Vocabulary slide and want to delete it. You also think a 
more appropriate location for the Overview slide may be above the agenda. 
Finally, you plan to have three slides to present the three main topics you plan 
to cover in the presentation. For this purpose, you want to add a third topic 
slide. Because you are not working with slide content, you will use the Slides 
tab to make these changes. 

 First you will delete slide 5, Vocabulary. 
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2

       •   Select slide 4 in the 

Slides tab.   

    •   If necessary, scroll 

the Slides tab to 

show slide 3.   

    •   Drag slide 4 above 

slide 3 in the Slides 

tab.    

 Your screen should be similar to  

Figure 1.19

  Additional Information 

 A solid horizontal line identifies the 
location where the slide will be placed 
when you stop dragging.  

1

       •   Click on the Slides 

tab to open it.   

    •   Scroll the Slides tab 

to see slide 5.   

    •   Click on slide 5 to 

select the slide.   

    •   Press  D .    

  Your screen should be similar to  

  Figure 1.18   

  Another Method 

 You can also choose Delete Slide from 
the selected slide’s context menu.  

PP1.22 Lab 1: Creating a Presentation

Slide 5, Vocabulary, was 

deleted and following slides 

renumbered

  Figure 1.18    

 The slide has been deleted and all subsequent slides renumbered. Next, you 
will move the Overview slide (4) above slide 3 using drag and drop 

Slide moved and 

all subsequent slides 

renumbered

  Figure 1.19    
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3

       •   Select slide 6 in the 

Slides tab.   

    •   Open the      drop-

down menu and 

choose Duplicate.    

     •   Scroll the Slides tab 

to see slides 5 to 7.    

  Your screen should be similar to  

  Figure 1.20   

  Another Method 

 You could also copy and paste the 

slide to duplicate it or use    in 

the Slides group and choose Duplicate 
Selected Slides from the drop-down 
menu.  

 Editing a Presentation PP1.23

 The Overview slide is now slide 3 and, again, all following slides are appropri-
ately renumbered. Finally, you will make a copy of slide 6. 

Slide 6 copied

Click to open

drop-down menu

  Figure 1.20    

 There are now three topic slides. The duplicate slide was inserted directly 
below the slide that was copied and is the selected slide.  

  MOVING, DEMOTING, AND PROMOTING BULLETED ITEMS 

 Now you are ready to enter the text for the three topic slides. You decide to 
enter the text for these slides using the Slide pane rather than the Outline tab. 
Simply clicking in an area of the slide in the Slide pane will make it the active 
area.       
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1

       •   Make slide 5 the 

current slide.   

    •   Click anywhere in 

the sample title text 

of slide 5 in the Slide 

pane to select the 

title placeholder.   

    •   Triple-click on the 

sample title to 

select it and type  

Why Are Pets 
Abandoned?   

    •   Click anywhere on 

the bulleted list to 

select the content 

placeholder.   

    •   Drag to select all the 

text in the content 

placeholder. 

 • Enter the following 

bulleted items (Press 

e  after each line, 

except the last, to 

create a new bullet):  

    Maintenance 
expenses  

    Change in 
lifestyle  

    Behavioral 
problems  

    Moving to a 
new location  

    Poor or 
deteriorating 
health        

 Your screen should be similar to  

Figure 1.21

  Another Method 

You also can click    in the 

Editing group of the Home tab and 

click    or use the shortcut 

key  c   +  A to select everything in a 
placeholder box. 

PP1.24 Lab 1: Creating a Presentation

Title and bullet 

placeholders replaced 

with new text

  Figure 1.21    

 In reviewing slide 5, you realize that moving to a new location is one of the 
most common reasons for pets to be abandoned, so you decide to move that to 
the top of the list. You can rearrange bulleted items in the Slide pane by select-
ing the item and dragging it to a new location in the same way you moved 
selections in the Outline tab. 
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Fourth bulleted 

item moved to first 

bullet position

  Figure 1.22    

 The fourth bullet is now the first bulleted item in the list. 
 In the next slide, you will enter information about how people can help the 

Animal Rescue Foundation. 

      

First bulleted item

  Figure 1.23    

 You want the next bulleted item to be indented below the first bulleted item. 
Indenting a bulleted point to the right    demotes    it, or makes it a lower or sub-
ordinate topic in the outline hierarchy. 

2

       •   Select all the text in 

the fourth bulleted 

item in the Slide 

pane.   

    •   Drag the selection to 

the beginning of the 

first bulleted item.    

 Your screen should be similar to  

Figure 1.22

3

       •   Make slide 6 the 

current slide.   

    •   Replace the sample 

title text with   How 
Can You Help?   

    •   Select all the text 

in the bulleted text 

placeholder.   

    •   Type   Donate 
your time and 
talent   

    •   Press   e .   

 Your screen should be similar to  

Figure 1.23
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PP1.26 Lab 1: Creating a Presentation

Demoted bullets

  Figure 1.24    

 When you demote a bulleted point, PowerPoint continues to indent to the 
same level until you cancel the indent. Before entering the next item, you want 
to remove the indentation, or    promote    the line. Promoting a line moves it to 
the left, or up a level in the outline hierarchy. 

Promoted bullets

  Figure 1.25    

4

  •   Press  t . 

    •   Type   Become a 
foster parent   

    •   Press  e .   

    •   Type   Work at 
adoption fairs   

    •   Press  e .   

 Your screen should be similar to  

Figure 1.24

5

       •   Press  s   +   t .   

    •   Type   Donate 
new or used 
items   

    •   Press   e .  

    •   Enter the next two 

bulleted items:  

    Crates and 
pads  

    Collars, leads, 
and other 
items    

 Your screen should be similar to  

Figure 1.25
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 You also can promote or demote bulleted items after the text has been entered. The 
insertion point must be at the beginning of the line to be promoted or demoted, or 
all the text must be selected. You will demote the last two bulleted items. 

Demoted bullets

  Figure 1.26    

 The last two items have been demoted. Next you will add more items to the 
bulleted list. 

AutoFit button

Text exceeds size 

of placeholder

  Figure 1.27    

6

       •   Select the two 

bulleted items 

“Crates and pads” 

and “Collars, leads, 

and other items”.   

    •   Press  t .   

    •   Move to the end of 

“Collars, leads, and 

other items”.   

    •   Press   e .   

  Your screen should be similar to  

  Figure 1.26   

7

       •   Type   Provide 
financial support   

    •   Press   e .  

    •   Enter the following 

three bulleted items:  

    Send a donation  

    Sponsor a 
foster pet  

    Sponsor an 
adoption   

    •   Promote the “Provide 

financial support” 

bullet.    

  Your screen should be similar to  

  Figure 1.27   
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PP1.28 Lab 1: Creating a Presentation

 As you entered more bulleted items, the slide’s text exceeds the size of the 

placeholder. When this happens a    AutoFit Options button appears at the 

bottom left corner of the placeholder. It provides options that allow you to 
control the AutoFit feature and to handle any overspilling text. The AutoFit 
feature will automatically adjust the line spacing and text size as needed to 
display the content inside the placeholder appropriately. Currently, this fea-
ture is off in this template. 

Size of text and line 

spacing automatically 

adjusted to fit text within 

the placeholder

  Figure 1.28    

 Now that the AutoFit Text to Placeholder option is on, the text size and line 
spacing of the bulleted items have been reduced to display the text more com-
fortably on the slide. If you were to add more text or increase or decrease the 
size of the placeholder, the AutoFit feature would continue to adjust the text 
size and spacing.  

  SPLITTING TEXT BETWEEN SLIDES 

 Although using AutoFit solved the problem, you decide that 10 bulleted items 
are too many for a single slide. Generally, when creating slides, it is a good 
idea to limit the number of bulleted items on a slide to six. It also is recom-
mended that the number of words on a line should not exceed five. You decide 
to split the slide content between two slides. 

8

       •   Click      AutoFit 

Options.   

    •   Choose AutoFit Text 

to Placeholder.    

  Your screen should be similar to  

  Figure 1.28   
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1

       •   With the bullet 

placeholder in slide 

6 still selected, click  

    AutoFit Options 

and choose Split Text 

Between Two Slides.   

    •   If necessary, scroll 

the Slides tab so that 

slides 6 and 7 are 

visible.    

 Your screen should be similar to  

Figure 1.29

 Having Trouble? 

You may have noticed that slide 6 in the 
Slides tab still displays all the bulleted 
items. Do not be concerned. The five 
bullets have been removed; however, 
the Slides tab has not updated to reflect 
the change.

 Editing a Presentation PP1.29

New slide inserted and text 

split between slides

New slide with 

same title and five 

bulleted items from 

previous slide

  Figure 1.29        

 A new slide containing the same title as the previous slide and five of the bul-
leted items from the previous slide is inserted into the presentation. Often 
when splitting text between slides, the content may not split appropriately and 
you may still need to make adjustments to the slides. You will move the first 
bulleted item on slide 7 to the last item on slide 6 using the keyboard shortcuts 
for the Cut and Paste commands. You also will edit the slide title of slide 7. 

      

New title

First bulleted item 

from slide 7 moved 

to slide 6

  Figure 1.30    

2

       •   On slide 7, replace 

the title text with  

 More Ways to 
Help!   

    •   Select the first 

bulleted item on slide 

7 and press  c   +  X 

to cut the selection.   

    •   Move to the end of 

the last item on slide 

6 and press   e .  

    •   Press   c    +    V to 

paste the item.    

 • If necessary, delete 

the new blank bullet 

line.

 Your screen should be similar to  

Figure 1.30
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PP1.30 Lab 1: Creating a Presentation

 Now the number of items on each slide seems much more reasonable. 
 Finally, you will add the text for the third topic slide. 

Text for topic slides 

complete

  Figure 1.31    

 The text for the three topic slides reflects the order of the topics in the Topics 
of Discussion slide.  

  CREATING A NUMBERED LIST 

 After looking at slide 4, you decide that it would be better if the topics of dis-
cussion were a numbered list. You can easily change the format of the bulleted 
items to a numbered list using the    Numbering command in the Para-
graph group on the Home tab. 

3

       •   Make slide 8 current.   

    •   Enter the slide title  

 How Does the 
Foundation 
Help?   

    •   Enter the following 

bulleted items:  

    Provides 
temporary 
homes  

    Provides 
obedience 
training  

    Provides 
veterinary care  

    Finds loving 
permanent 
homes   

    •   Open the Outline 

tab and scroll the 

tab to see slides 4 

through 8.    

 Your screen should be similar to  

Figure 1.31
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Solid line border 

indicates entire 

placeholder will 

be affected by your 

actions

Converts selection to a 

numbered list

  Figure 1.32    

 Notice the cursor does not appear in the placeholder box. This is because a 
solid line around the placeholder indicates your action will affect the entire 
placeholder rather than individual parts, such as the text, of the placeholder. 
The bullets have been replaced with an itemized numbered list.  

  MOVING, DEMOTING, AND PROMOTING NUMBERED ITEMS 

 Now it is obvious to you that you entered the topics in the wrong order. You 
want to present the information about the Foundation before information 
about how individuals can help. Just like a bulleted item, an item in a num-
bered list can be moved easily by selecting it and dragging it to a new location. 

1

       •   Open the Slides tab 

and make slide 4 

current.   

    •   Click anywhere in 

the bulleted items 

placeholder on 

slide 4.   

    •   Click on the dashed-

line border of the 

placeholder box to 

change it to a solid 

line.   

    •   Click     

 Numbering in the 

Paragraph group on 

the Home tab.    

 Your screen should be similar to  

Figure 1.32
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PP1.32 Lab 1: Creating a Presentation

The second and third

items switched

positions and items

renumbered

  Figure 1.33    

 As soon as you clicked inside the placeholder, the cursor appeared and the 
solid-line border changed to a dashed-line border, indicating you can edit the 
contents of the placeholder. The third item in the numbered list is now the sec-
ond item, and PowerPoint automatically renumbered the list for you. 

 Because you don’t want to miss anything, you decide to go back and review 
the information you’ve entered so far. As you go back through the slides, you 
realize that you forgot to include the Animal Angels volunteer group as a topic 
to be discussed. You will add it to the Topics of Discussion slide as a subtopic 
below the “How can you help?” topic. 

1

       •   Select the third item 

in the placeholder on 

slide 4.   

    •   Drag the selection up 

to the beginning of 

the second line.    

  Your screen should be similar to  

  Figure 1.33   
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New demoted 

numbered list item

  Figure 1.34    

 The numbering for the subtopic begins with one again. The new item is too 
important to be demoted on the list, so you decide to promote it and move it 
higher on the list. 

Promoted item

Numbered list updated 

to reflect new order

  Figure 1.35     

The numbered list has again been appropriately adjusted.

2

       •   Open the Outline tab 

to review the slide 

content.   

    •   Click at the end of the 

third numbered list 

item on slide 4 and 

press   e .  

    •   Press  t  and type  

 Who are 
Animal 
Angels?    

 Your screen should be similar to  

Figure 1.34

3

       •   Select the entire 

fourth line.   

    •   Press   s    +    t   to 

promote the fourth 

line.   

    •   Drag the selected 

item to the beginning 

of the third line.    

  Your screen should be similar to  

  Figure 1.35   
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 Having Trouble? 

See “Saving a File,” in the Introduction 
to Microsoft Office 2010 to review this 
feature.

1

       •   Open the File tab and 

click .   

    •   Replace the proposed 

file name in the File 

Name text box with   

 Volunteer    

     •   Select the location 

where you will save 

your solution files.    

  Your screen should be similar to  

  Figure 1.36   

  Having Trouble? 

 If you used the student data file pp01_
Training for this lab, choose Save As 
from the File tab. The file name in the 
Save As dialog box will be the name of 
the file you opened.  

  Additional Information 

The file extensions may or may not 
be displayed, depending upon your 
Windows folder settings. 

PP1.34 Lab 1: Creating a Presentation

  SAVING A PRESENTATION 

 You have just been notified about an important meeting that is to begin in a 
few minutes. Before leaving for the meeting, you want to save the presentation 
so that you don’t lose your work.     

 The Save or Save As commands on the File tab are used to save files. When 
a presentation is saved for the first time, either command can be used to dis-
play the Save As dialog box, in which you specify the location to save the file 
and the file name. 

Address bar displays 

current location

Specifies type of file to 

save as New file name

File list

  Figure 1.36    

 The file list displays folder names as well as the names of PowerPoint files (if 
any) stored in the current location. Only PowerPoint presentation files are 
listed, because the selected file type in the Save As Type list box is PowerPoint 
Presentation. Depending on what file type you choose, a different file exten-
sion will be added to the file name. Presentation files have a default file exten-
sion of .pptx.  

 You can also save PowerPoint presentations as an image file using the 
.gif, .tif, or .jpg file extension. When you save a presentation as an image 
file, you are given the choice to save the Current Slide Only or Every Slide 
as an image, in which case each slide will be saved as a separate image file. 

 In this case, you will use the default presentation file type (.pptx). 
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3

    •  Open the File tab and click .

  Additional Information 

    If you are ending your lab session 
now, open the File tab and click 

   to exit the program.   

 Opening an Existing Presentation PP1.35

New file name

  Figure 1.37    

 The presentation is now saved to the location you specified in a new file named 
Volunteer and the new file name is displayed in the application window title 
bar. The view in use at the time the file is saved also is saved with the file. 

 You are now ready to close the file.         

2

       •   Click    .   

 Your screen should be similar to  

Figure 1.37

 The presentation is closed, and an empty workspace is displayed. Always save 
your slide presentation before closing a file or leaving the PowerPoint pro-
gram. As a safeguard against losing your work if you forget to save the presen-
tation, PowerPoint will remind you to save any unsaved presentation before 
closing the file or exiting the program. 

Opening an Existing Presentation

 After returning from your meeting, you continued to work on the presenta-
tion. You revised the content of several of the slides and added information 
for several new slides. Then you saved the presentation using a new file name. 
You will open this file to see the changes and will continue working on the 
presentation. 
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1

       •   Open the File tab and 

click .    

     •   If necessary, 

select the location 

containing your data 

files.   

    •   Select 

pp01_Volunteer1.    

     •   Click    .   

     •   Open the Outline tab.   

    •   Replace “Your Name” 

in slide 1 with your 

name.   

    •   Scroll the Outline tab 

to see the additional 

content that has 

been added to the 

presentation.    

 Your screen should be similar to  

Figure 1.38

  Another Method 

 The keyboard shortcut to open a file is 
 c   +  O.  

  Another Method 

 You also could double-click the file 
name to both select it and choose 

  .  

  Additional Information 

 You also can quickly open a recently 
used file by selecting it from the Recent 
Documents list in the File tab.  

PP1.36 Lab 1: Creating a Presentation

File name of open file

Spelling errors

  Figure 1.38    

 The presentation now contains 10 slides, and all the sample text has been 
replaced with text for the volunteer recruitment presentation, except for slide 9.    
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       •   Open the Review tab.   

    •   Click      in the 

Proofing group.    

 Your screen should be similar to  

Figure 1.39

  Another Method 

 The keyboard shortcut to check spelling 
is  7 .  

  Additional Information 

 The spelling checker identifies many 
proper names and technical terms as 
misspelled. To stop this from occurring, 
use the Add Words To option to add 
those names to the custom dictionary.  

  Additional Information 

Unlike Word 2010, Powerpoint does not 
check for grammar errors. 

 Using Spelling Checker PP1.37

  Using Spelling Checker 

  As you entered the information on the additional slides, you left some typing 
errors uncorrected. To correct the misspelled words, you can use the shortcut 
menu to correct each individual word or error, as you learned earlier. How-
ever, in many cases, you may find it more efficient to wait until you are fin-
ished writing before you correct any spelling or grammatical errors. Rather 
than continually break your train of thought to correct errors as you type, you 
can check the spelling on all slides of the presentation at once by running the 
spelling checker. 

Starts spelling checker

Misspelled word
Change To text box

Suggestions list box

  Figure 1.39    

 The program jumps to slide 4; highlights the first located misspelled word, 
“Vetinerary,” in the Outline pane; and opens the Spelling dialog box. The Spell-
ing dialog box displays the misspelled word in the Not in Dictionary text box. 
The Suggestions list box typically displays the words the spelling checker has 
located in the dictionary that most closely match the misspelled word. 

 In this case, the spelling checker does not display any suggested replace-
ments because it cannot locate any words in the dictionaries that are similar 
in spelling. If there are no suggestions, the Not in Dictionary text box simply 
displays the word that is highlighted in the text. When none of the suggestions 
is correct, you must edit the word yourself by typing the correction in the 
Change To text box. 
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       •   Type   Veterinary  

 in the Change To text 

box.    

     •   Click    .   

 Your screen should be similar to  

Figure 1.40

  Having Trouble? 

 If necessary, move the dialog box by 
dragging its title bar to see the located 
misspelled word.  

  Additional Information 

 The replacement text must be entered 
exactly as you want it to appear, 
including capitalization.  

  Additional Information 

 You also can edit words directly 
in the presentation and then click 

   to continue checking 

spelling.  

3

       •   Click    .  

    •   Change the remaining  

spelling errors.   

    •   Click      in 

response to the 

message telling you 

that the spelling 

check is complete.   

    •   Open the File tab, 

click  and 

save the revised 

presentation as  

 Volunteer1   to 

your solution file 

location.    

 Your screen should be similar to  

Figure 1.41

PP1.38 Lab 1: Creating a Presentation

Suggested corrections

Next misspelled 

word identified

Correct 

replacement

  Figure 1.40    

 The corrected replacement is made in the slide. After the Spelling dialog box 
is open, the spelling checker continues to check the entire presentation for 
spelling errors. The next misspelled word, “trics,” is identified. In this case, the 
suggested replacement is correct. 

New file name

Spelling errors cleared

  Figure 1.41    

 The Spelling indicator in the Status bar shows that all spelling errors have 
been resolved.   
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   Having Trouble? 

 Do not be concerned if your screen 
displays a different number of slides per 
row. This is a function of the size of your 
monitor and your monitor settings.   

1

       •   Click      Slide Sorter 

in the status bar.              

     •   Set the zoom to 90%.   

    •   Click on slide 1.    

  Your screen should be similar to  

  Figure 1.42   

 Having Trouble? 

Pointing to a view button displays its 
name in a ScreenTip.

 Another Method 

You also could switch to Slide 

Sorter view by clicking    in the 

Presentation Views group of the View tab.

 Using Slide Sorter View PP1.39

  Using Slide Sorter View 

  To get a better overall picture of the presentation, you will switch to Slide 
Sorter view. This view displays thumbnail images of each slide in the work 
area and is particularly useful for rearranging slides to improve the flow and 
organization of the presentation. Clicking on a thumbnail selects the slide and 
makes it the current slide.  

Current slide

Slide Sorter view

90% zoom
Click to decrease 

zoom percent

  Figure 1.42    

 The currently selected slide, slide 1, appears with a yellow border around it. 
Viewing all the slides side by side helps you see how your presentation flows. 
You realize that the second slide is no longer necessary because you added 
your name to the opening slide. You also decide to delete slide 9 because you 
plan to add any necessary information to other slides. As you continue to look 
at the slides, you can now see that slides 7 and 8 are out of order and do not 
follow the sequence of topics in the Topics of Discussion slide. 

  SELECTING AND DELETING SLIDES 

 You will delete slides 2 and 9. In this view, it is easy to select and work with 
multiple slides at the same time. To select multiple slides, hold down  c  while 
clicking on each slide to select it. 
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       •   Select slide 2, hold 

down  c , and click 

on slide 9.   

    •   Press  D .   

    •   Increase the zoom to 

100%.    

 Your screen should be similar to  

Figure 1.43

  Additional Information 

 The zoom setting for each view is set 
independently and remains in effect 
until changed to another zoom setting.  

  Additional Information 

 You can use  D  to delete a slide 
in Slide Sorter view and in the Slides 
tab. However, in the Slide pane, using 
 D  deletes text or placeholder 
content.  

PP1.40 Lab 1: Creating a Presentation

Two slides deleted

  Figure 1.43    

 The slides have been deleted, and all remaining slides have been appropriately 
renumbered.  

  MOVING SLIDES 

 Now you want to correct the organization of the slides by moving slides 6 
and 7 before slide 4. To reorder a slide in Slide Sorter view, you drag it to its 
new location using drag and drop. As you drag the mouse, an indicator line 
appears to show you where the slide will appear in the presentation. When 
the indicator line is located where you want the slide to be placed, release the 
mouse button. You will select both slides and move them at the same time. 
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       •   Select slides 6 and 7.   

    •   Point to either 

selected slide and 

drag the mouse until 

the indicator line is 

displayed before 

slide 4.        

     •   Release the mouse 

button.        

  Your screen should be similar to  

Figure 1.44   

 Additional Information 

The mouse pointer appears as    

when you drag to move a slide.

 Another Method 

You also can use the    Cut and 

 commands in the Clipboard 

group on the Home tab to move slides in 
Slide Sorter view.

1

       •   Click in the space 

before slide 5.    

     •   Open the Home tab.   

    •   Open the      drop-

down menu in the 

Slides group.    

 Your screen should be similar to  

Figure 1.45

  Additional Information 

 The indicator line shows you where the 
new slide will be inserted.  

 Using Slide Sorter View PP1.41

Selected slides 

moved 

  Figure 1.44    

 The slides now appear in the order in which you want them.  

  SELECTING A SLIDE LAYOUT 

 During your discussion with the foundation director, it was suggested that you 
add a slide showing the history of the organization. To include this informa-
tion in the presentation, you will insert a new slide after slide 4. 

      

Select slide layout

for new slide

Two Content layout

  Figure 1.45    
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 The drop-down menu displays 9 built-in slide layouts. The number of avail-
able layouts varies with the template you are using.     

    A layout    defines the position and format for objects and text on a slide. Layouts provide placeholders for slide 
titles and slide content such as text, tables, diagrams, charts, or clip art. Many of these placeholders are shown 
in the following diagram. 

     You can change the layout of an existing slide by selecting a new layout. If the new layout does not include 
placeholders for objects that are already on your slide (for example, if you created a chart and the new layout 
does not include a chart placeholder), you do not lose the information. All objects remain on the slide, and the 
selected layout is automatically adjusted by adding the appropriate type of placeholder for the object. Alter-
natively, as you add new objects to a slide, the layout automatically adjusts by adding the appropriate type of 
placeholder. You also can rearrange, size, and format placeholders on a slide any way you like to customize the 
slide’s appearance. 

To make creating slides easy, use the predefined layouts. The layouts help you keep your presentation format 
consistent and, therefore, more professional.

4 Concept   Layout 

 You need to choose the layout that best accommodates the changes you dis-
cussed with the director. Because this slide will contain two columns of text 
about the history of the organization, you will use the Two Content layout. 
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       •   Choose Two Content.   

    •   Double-click on the 

slide to switch back 

to Normal view.        

     •   Open the Slides tab.    

 Your screen should be similar to  

Figure 1.46

 Additional Information 

The current slide does not change when 
you switch views.

 Using Slide Sorter View PP1.43

New slide contains 

three placeholders

New slide inserted

  Figure 1.46  

 A new Two Content slide is inserted with the same design elements as the 
other slides in the presentation. The Two Content layout contains three place-
holders, but unlike the template slides, the placeholders on the inserted slide 
do not contain sample text. When you select the placeholder, you can simply 
type in the text without having to select or delete any sample text.  

  CHANGING A PLACEHOLDER 

 You will add text to the slide presenting a brief history of the Animal Rescue 
Foundation. First, you will enter the slide title and then the list of dates and 
events. 

ole31346_PPLab1_001-090.indd   PP1.43ole31346_PPLab1_001-090.indd   PP1.43 9/3/10   10:55 PM9/3/10   10:55 PM



Confirming Pages

WWW.MHHE.COM/OLEARY

PowerPoint 2010

PP1.44 Lab 1: Creating a Presentation

      

Slide title

Two columns of text

Sizing

handles

  Figure 1.47    

 The left placeholder is too big for its contents and the right is too small, forc-
ing some items to wrap to a second line. To correct the size, you can adjust the 
size of the placeholders.  

  SIZING A PLACEHOLDER 

 The four circles and squares that appear at the corners and sides of a selected 
placeholder’s border are    sizing handles    that can be used to adjust the size of the 
placeholder. Dragging the corner sizing handles will adjust both the height and 
width at the same time, whereas the center handles adjust the associated side 
borders. When you point to the sizing handle, the mouse pointer appears as   , 
indicating the direction in which you can drag the border to adjust the size. 

1

       •   Click in the title 

placeholder.   

    •   Type   Animal 
Rescue 
Foundation 
History   

    •   Use the AutoFit 

Options menu to 

fit the title to the 

placeholder.   

    •   Click in the left text 

placeholder and 

enter the information 

shown below. 

Remember to press 

 e  to create a new 

line (except after the 

last entry).  

    1995  

    1996  

    1997  

    2005   

    •   In the same manner, 

enter the following 

text in the right text 

placeholder:  

    Founded by 
Steve Dow  

    Built first 
shelter  

    Began 
volunteer 
program  

    Rescued 3000 
animals!    

 Your screen should be similar to  

Figure 1.47
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 Using Slide Sorter View PP1.45

Left placeholder 

adjusted to fit content Right placeholder 

adjusted to fit each 

bullet on a single line

  Figure 1.48     

  MOVING A PLACEHOLDER 

 Next, you want to decrease the blank space between the two columns. Then 
you want to move both placeholders so they appear more centered in the 
space. An object can be moved anywhere on a slide by dragging the place-
holder’s border. The mouse pointer appears as    when you can move a place-
holder. As you drag the placeholder, an opaque white copy of the placeholder 
is displayed to show your new location. 

1

       •   On the right 

placeholder, drag 

the left-center sizing 

handle to the left until 

each item appears on 

one line.   

    •   Select the left text 

placeholder and 

drag the right-center 

sizing handle to the 

left (see   Figure 1.48 ).  

    •   With the left 

placeholder still 

selected, hold down  

s  while clicking 

on the right 

placeholder border to 

select both.   

    •   Use the bottom-

middle sizing 

handle to decrease 

the height of the 

placeholders to fit 

the text.    

 Your screen should be similar to  

Figure 1.48
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PP1.46 Lab 1: Creating a Presentation

  Figure 1.49     

  ADDING AND REMOVING BULLETS 

 Next, you want to remove the bullets from the items on the history slide. You 
can quickly apply and remove bullets using    Bullets in the Paragraph 
group on the Home tab. This button applies the bullet style associated with the 
design template you are using. Because the placeholder items already include 
bullets, using this button will remove them. 

Adds and 

removes bullets

Bullets removed 

from items in both 

placeholders

  Figure 1.50    

1

       •   Click outside the 

placeholders to clear 

the selection.   

    •   Select the left 

placeholder and 

point to the edge 

of the placeholder 

(not a handle) until 

the mouse pointer 

appears as    .  

    •   Drag the selected 

placeholder to the 

right closer to the 

right placeholder.  

   • Select both 

placeholders and 

drag to center them 

horizontally in the 

slide as shown in  

  Figure 1.49.    

    •   Save your changes to 

the presentation.    

  Your screen should be similar to  

  Figure 1.49   

1

       •   With both text 

placeholders still 

selected, click     

 Bullets from the 

Paragraph group 

in the Home tab to 

remove all bullets.    

 Your screen should be similar to  

Figure 1.50
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 Formatting Slide Text PP1.47

 The bullets are removed from all the items in both placeholders. Now, how-
ever, you think it would look better to add bullets back to the years in the first 
column. 

Bullets added to 

selected items

  Figure 1.51    

 Bullets appear before the selected text items only.    

  Formatting Slide Text 

  The next change you want to make to the presentation is to improve the 
appearance of the title slide. Although the design template you are using 
already includes many formatting features, you want this slide to have more 
impact. 

 Applying different formatting to characters and paragraphs can greatly 
enhance the appearance of the slide.    Character formatting    features affect the 
selected characters only. They include changing the character style and size, 
applying effects such as bold and italics, changing the character spacing, and 
adding animated text effects.    Paragraph formatting    features affect an entire 
paragraph. A paragraph is text that has an  e  at the end of it. Each item in 
a bulleted list, title, and subtitle is a paragraph. Paragraph formatting features 
include the position of the paragraph or its alignment between the margins, 
paragraph indentation, spacing above and below a paragraph, and line spac-
ing within a paragraph.  

   CHANGING FONTS 

 First, you will improve the appearance of the presentation title by changing 
the font of the title text. There are two basic types of fonts: serif and sans serif. 
   Serif fonts    have a flair at the base of each letter that visually leads the reader 
to the next letter. Two common serif fonts are Roman and Times New Roman. 

2

       •   Select the four years 

in the left column.   

    •   Click      Bullets 

from the Paragraph 

group in the Home 

tab.   

    •   Click outside the 

selected placeholder 

to deselect it.   

    •   Save the presentation 

again.    

  Your screen should be similar to  

  Figure 1.51   
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  Having Trouble? 

 Refer to the section “Formatting Text” in 
the Introduction to Microsoft Office 2010 
to review this feature.  

  Additional Information 

 The font used in the title is Trebuchet 
MS (Headings), as displayed in the 

   Font button. It is 
automatically used in all headings in 
this template.  

PP1.48 Lab 1: Creating a Presentation

Serif fonts generally are used for text in paragraphs.    Sans serif fonts    do not 
have a flair at the base of each letter. Arial and Helvetica are two common sans 
serif fonts. Because sans serif fonts have a clean look, they are often used for 
headings in documents. 

 Each font can appear using a different font size. Several common fonts in 
different sizes are shown in the following table. 

Font Name Font Type Font Size

Calibri Sans serif This is 10 pt.

This is 16 pt.
Courier New Serif This is 10 pt.

This is 16 pt.
Garamond Serif This is 10 pt.

This is 16 pt.

 Using fonts as a design element can add interest to your presentation and give 
your audience visual cues to help them find information quickly. It is good 
practice to use only two or three different fonts in a presentation, because too 
many can distract from your presentation content and can look unprofessional. 

 To change the font before typing the text, use the command and then type. 
All text will appear in the specified setting until another font setting is selected. 
To change a font setting for existing text, select the text you want to change 
and then use the command. If you want to apply font formatting to a word, 
simply move the insertion point to the word and the formatting is automati-
cally applied to the entire word. 

 The    Font button in the Font tab or on the Mini toolbar that 
appears when you select text is used to change the font style. As you select a 
font from the drop-down menu, a live preview of how the selected font will 
appear is displayed in the document. 
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       •   Select the text “Join 

Animal Angels” in the 

Slide pane on slide 1.   

    •   Open the      Font 

drop-down list in the 

Mini toolbar.   

    •   Point to several 

fonts to see the live 

preview.    

 Your screen should be similar to  

Figure 1.52

  Having Trouble? 

 Refer to the section “Using the Mini 
Toolbar” in the Introduction to Microsoft 
Office 2010 to review this feature.  

  Additional Information 

 The Live Preview feature is also 
available with many other formatting 
features.  

2

       •   Scroll the menu and 

choose Comic Sans 

MS.    

 Your screen should be similar to  

Figure 1.53

  Another Method 
 You also could use    
Font in the Font group of the Home tab 
to change the font.  

 Formatting Slide Text PP1.49

Font used for 

selected text 

Live Preview shows 

how the formatting will 

affect selected text

Selected title text

  Figure 1.52    

 The selected text in the document appears in the font style you have selected 
in the menu. With Live Preview, you can see how the text will look with the 
selected font before you click the one that you want. You want to change the 
font to a design that has a less serious appearance. 

      

Title appears in 

selected font

  Figure 1.53    

 The text has changed to the new font style, and the Font button displays the 
font name used in the current selection.  
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       •   Open the      Font 

Size drop-down list 

on the Mini toolbar.    

     •   Point to several 

different sizes to see 

how the font size 

changes using Live 

Preview.   

    •   Scroll the list and 

choose 60.        

 Your screen should be similar to  

Figure 1.54

  Having Trouble? 

 If the Mini toolbar is no longer displayed, 
right click on the selection to display 
it again.  

 Another Method 

You also could use    Font Size in 
the Font group.

  Another Method 

 Using    Increase Font Size in the 

Font group or the Mini toolbar will 
incrementally increase the font size. The 
keyboard shortcut is  c   +   s   +   > .  

  Additional Information 

 Use    Decrease Font Size or  c   +  

 s   +   <  to incrementally decrease 
the point size of selected text.  

  Additional Information 

 If a selection includes text in several 
different sizes, the smallest size appears 
in the Font Size button followed by a 
plus sign.  

PP1.50 Lab 1: Creating a Presentation

  CHANGING FONT SIZE 

 The title text is also a little smaller than you want it to be. 

Current font size

Increase Font

Size button

  Figure 1.54 

 The font size increased from 44 points to 60 points. The Font Size button dis-
plays the point size of the current selection.  

  APPLYING TEXT EFFECTS 

 Next, you want to further enhance the title slide by adding    text effects    such as 
color and shadow to the title and subtitle. The table below describes some of 
the effects and their uses. The Home tab and the Mini toolbar contain buttons 
for many of the formatting effects. 
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       •   If necessary, select 

the title text.   

    •   Click      Text Shadow 

in the Font group.        

     •   Open the      Font 

Color menu to display 

a gallery of colors.   

    •   Choose Green, Accent 1, 

Darker 25% in the 

Theme Colors section.    

     •  Click the subtitle 

placeholder to select it.   

 Your screen should be similar to  

Figure 1.55

 Additional Information 

Many formatting commands are toggle 
commands. This means the feature can 
be turned on and off simply by clicking 
on the command button.

      Additional Information 

 A ScreenTip displays the name of the 
color when selected.  

  Additional Information 

 You will learn about themes in Lab 2.  

 Formatting Slide Text PP1.51

Format Example Use

Bold, italic Bold Italic Adds emphasis

Underline Underline Adds emphasis

Superscript “To be or not to be.”1 Used in footnotes and formulas

Subscript H2O Used in formulas

Shadow Shadow Adds distinction to titles and headings

Color Color Color Color Adds interest

 You decide to add color and a shadow effect to the main title first. 

Font Color button displays 

last selected color

Shadow effect

applied to title

Shadow button Opens Font Color gallery

  Figure 1.55    

 The selected color and slight shadow effect make the title much more interest-
ing. Also notice the color in the Font Color button is the green color you just 
selected. This color can be quickly reapplied to other selections now simply by 
clicking the button. 

Next you will enhance the two subtitle lines. Notice that the subtitle place-
holder box does not include the second subtitle line. Although the second line 
was included in the placeholder when it was moved to this slide, the place-
holder did not automatically increase in size to accommodate the new text. 
You will increase the size of the placeholder to visually include this text. 

Shadow
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       •   Drag the bottom-

middle sizing handle 

down to increase 

the size of the 

placeholder to 

include both subtitle 

lines.   

    •   Select the text 

“Animal Rescue 

Foundation”.   

    •   Open the      Font 

Color gallery.   

    •   Choose Green, 

Accent 1, Darker 50% 

in the Theme Colors 

section.   

    •   Click      Bold on the 

Mini toolbar.    

     •   Select your name and 

click      Underline on 

the Home tab.    

 Your screen should be similar to  

Figure 1.56

  Another Method 

 The keyboard shortcut is  c   +  B.  

  Another Method 

 The keyboard shortcut is  c   +  U.  

PP1.52 Lab 1: Creating a Presentation

Adds bold effect

Underline applied 

to name

Adds underline effect

Bold and color 

applied to subtitle text

  Figure 1.56    

 After reviewing your changes, you decide that underlining your name doesn’t 
have the right look. You’ll italicize the entire line instead and make the font 
smaller. 
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 Working with Graphics PP1.53

Adds italic effect

Italicized text

  Figure 1.57    

 Now the title slide has much more impact.    

  Working with Graphics 

  Finally, you want to add a picture to the presentation. A picture is one of sev-
eral different graphic objects that can be added to a slide.     

3

       •   Click      Underline.   

    •   Select the entire 

second line of the 

subtitle.   

    •   Click      Italic.   

    •   Click      Decrease 

Font Size three times.   

    •   Click somewhere 

outside the 

placeholder.    

 Your screen should be similar to  

Figure 1.57
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  Additional Information 

 When your computer is connected to 
a scanner, you also can scan a picture 
and insert it directly into a slide without 
saving it as a file first.  

PP1.54 Lab 1: Creating a Presentation

 Graphic files can be obtained from a variety of sources. Many simple drawings 
called    clip art    are available in the Clip Organizer, a Microsoft Office tool that 
arranges and catalogs clip art and other media files stored on the computer’s 
hard disk. The Clip Organizer’s files, or clips, include art, sound, animation, 
and movies you can add to a presentation. Additionally, if you are connected 
to the Internet, Microsoft’s  Office.com  Web site is automatically accessed for 
even more graphics. 

 Digital images created using a digital camera are one of the most common 
types of graphic files. You also can create graphic files using a scanner to 
convert any printed document, including photographs, to an electronic for-
mat. Most images that are scanned and inserted into documents are stored as 
Windows bitmap files (.bmp). All types of graphics, including clip art, photo-
graphs, and other types of images, can be found on the Internet. These files 
are commonly stored as .jpg or .pcx files. Keep in mind that any images you 
locate on the Internet may be protected by copyright and should only be used 
with permission. You also can purchase CDs containing graphics for your use.

 A    graphic    is a nontext element or object, such as a drawing or picture, that can be added to a slide. A graphic 
can be a simple drawing object consisting of shapes such as lines and boxes. A    drawing object    is part of your 
presentation document. A    picture    is an image such as a graphic illustration or a scanned photograph. Pictures are 
graphics that were created from another program and are inserted in a slide as    embedded objects.    An embedded 
object becomes part of the presentation file and can be opened and edited using the    source program,    the pro-
gram in which it was created. Any changes made to the embedded object are not made to the original picture file 
because they are independent. Several examples of drawing objects and pictures are shown below.       

Add graphics to your presentation to help the audience understand concepts, to add interest, and to make your 
presentation stand out from others.

5 Concept 

Photograph Graphic illustration Drawing object

 Graphics 

ole31346_PPLab1_001-090.indd   PP1.54ole31346_PPLab1_001-090.indd   PP1.54 9/3/10   10:55 PM9/3/10   10:55 PM



Confirming Pages

1

       •   Select slide 2.   

    •   Open the Insert tab.   

    •   Click    .   

  Your screen should be similar to  

  Figure 1.58   

  Having Trouble? 

 Your Clip Art task pane may already 
display graphics if this feature was 
previously used while the application 
was still running.  

 Working with Graphics PP1.55

   INSERTING A GRAPHIC FROM THE CLIP ORGANIZER 

 You want to add a graphic to the second slide. First you decide to check the 
Clip Art gallery to see if you can find an image that will work as an attention 
getter. The Insert tab includes commands that are designed to enhance a pre-
sentation by adding features such as shapes and illustrations to movies and 
sounds. 

Clip Art task pane

Inserts Clip Art

  Figure 1.58    

 In the Clip Art task pane, you enter a word or phrase that is representative 
of the type of picture you want to locate. You also can specify the location to 
search and the type of media files, such as clip art, movies, photographs, or 
sound, to display in the search results. Since each of the items on this slide is 
a question, you decide to look for graphics of question marks. 
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       •   If necessary, select 

any existing text in 

the Search For text 

box.   

    •   In the Search For 

text box, type  

 question   

    •   If necessary, 

select the Include  

  Office.com    content 

check box.   

    •   Open the Results 

Should Be drop-down 

list, if necessary, 

choose Illustrations 

to select it, and 

deselect the all other 

options.        

     •   Click outside the 

drop-down list to 

close it.   

    •   Click    .       

  Your screen should be similar to  

  Figure 1.59   

  Having Trouble? 

 If your thumbnails appear in a single 
column, increase the width of your task 
pane by dragging the left edge of the 
pane until two columns are displayed.  

 Having Trouble? 

Do not worry if the thumbnails displayed 
on your screen do not match those 
shown in  Figure 1.59 , because the 
online clip art is continuously changing.

 Having Trouble? 

Click the box next to an option to select 
or deselect (clear the checkmark).

PP1.56 Lab 1: Creating a Presentation

Opens Results Should 

Be drop-down list

Enter descriptive text 

in Search For text box

Thumbnail images of 

located clip art displayed 

in Results list

  Figure 1.59    

 The program searches the Microsoft Clip Organizer on your computer and, 
if an Internet connection is established, searches Microsoft’s  Office.com  Web 
site for clip art and graphics that match your search term. The Results list 
displays thumbnails of all located graphics. The pictures stored on your com-
puter in the Microsoft Clip Art gallery appear first in the results list, followed 
by the Office Online clip art. 

 Pointing to a thumbnail displays a ScreenTip containing the    keywords,    
descriptive words or phrases, associated with the graphic and other informa-
tion about the picture properties. It also displays a drop-down list bar that 
accesses the item’s shortcut menu. The shortcut menu commands are used 
to work with and manage the items in the Clip Organizer. Because it is some-
times difficult to see the graphic in the thumbnail, you can preview it in a 
larger size. 
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3

       •   Scroll the Results list 

to view additional 

images.   

    •   Point to any graphic 

and click      to open 

the thumbnail menu.   

    •   Choose Preview/

Properties.    

 Your screen should be similar to  

Figure 1.60

 Having Trouble? 

Do not worry if your preview image does 
not match  Figure 1.60 . It will only match 
if you selected the same graphic in the 
results area.

  Having Trouble? 

 If this graphic is not available in the Clip 
Organizer, just choose a question mark 
graphic that you like from the results list.  

4

       •   Click      to 

close the dialog box.   

    •   Scroll the Results list 

to locate the graphic 

shown in    Figure 1.61.    

    •   Click on the graphic 

to insert it in the slide.    

  Your screen should be similar to  

  Figure 1.61   

  Another Method 

 You also could choose Insert from the 
thumbnail’s shortcut menu to insert the 
graphic.  

 Working with Graphics PP1.57

File information 

about selected graphic
Large image of 

selected clip art

Opens thumbnail 

menu

  Figure 1.60        

 The Preview/Properties dialog box displays the selected graphic in a larger size 
so it is easier to see. It also displays more information about the properties asso-
ciated with the graphic. Notice the search word you entered appears as one of 
the keywords. Now you will scroll the results list of graphics to find one you like. 

Selected clip art 

inserted into slide

Selected clip art

  Figure 1.61    
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  Additional Information 

 Be careful when increasing the size of 
a picture (bitmap) image, as it can lose 
sharpness and appear blurry if enlarged 
too much.  

1

       •   If necessary, click on 

the graphic to select 

it.   

    •   Drag the graphic to 

position it as shown 

in    Figure 1.62.    

    •   Drag the top left 

corner sizing handle 

inward to decrease 

its size to that shown 

in    Figure 1.62.     

     •   Close the Clip Art 

task pane.    

 Your screen should be similar to  

Figure 1.62

  Additional Information 

 To maintain an object’s proportions 
while resizing it, hold down  s  while 
dragging the sizing handle.  

PP1.58 Lab 1: Creating a Presentation

 The clip art image is inserted in the center of the slide on top of the text. It is a 
selected object and can be sized and moved like any other selected object. The 
Picture Tools Format tab is automatically displayed in the Ribbon, in anticipa-
tion that you may want to modify the graphic.  

  SIZING AND MOVING A GRAPHIC 

 First you need to size and position the picture on the slide. A graphic object is 
sized and moved just like a placeholder. You want to decrease the graphic size 
slightly and move it to the bottom right of the slide. 

Top left corner sizing 

handle

Resized and 

repositioned graphic

Picture Tools Format tab

  Figure 1.62    

 The clip art image is now smaller and placed in the correct position on the 
slide.  

  ADDING GRAPHIC EFFECTS 

 You can use the picture effects on the Picture Tools Format tab to customize 
the look of the graphic to suit your presentation. There are many effects that 
you can use to improve the appearance of graphics in your presentation. The 
first enhancement you would like to make is to change the color of the ques-
tion mark so it coordinates with the slide design. 
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 Working with Graphics PP1.59

Changes the color of 

clip art images

Opens Picture Styles 

gallery

Clip art recolored

  Figure 1.63    

 Next, you want to enhance the graphic by applying a picture style to it. A    style  
is a combination of formatting options that can be applied in one easy step. 
In the case of    picture styles,    the combinations consist of border, shadow, and 
shape effects. You also can create your own picture style effects by selecting 
specific style elements, such as borders and shadows, individually using the 

  ,   , and    commands. 

Picture Styles gallery

  Figure 1.64    

1

       •   With the clip art 

selected, click  

    Color   in 

the Adjust group of 

the Picture Tools 

Format tab.   

    •   Point to the choices 

in the Recolor gallery 

to see live previews.   

    •   Choose Light Green, 

Accent Color 5 Dark 

from the gallery 

(second row, fifth 

column).    

 Your screen should be similar to  

Figure 1.63

2

       •   Click      More in the 

Picture Styles group 

to open the Picture 

Styles gallery.    

 Your screen should be similar to  

Figure 1.64
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PP1.60 Lab 1: Creating a Presentation

 When you point to a style, the style name appears in a ScreenTip, and the Live 
Preview feature shows how the selected graphic will look with the selected 
picture style. 

Metal Rounded Rectangle 

picture style applied

  Figure 1.65    

 As you look at the picture, you decide to remove the rectangle and use the oval 
shape with the thin black border instead. You will then modify the picture 
style by changing the border color and removing the reflection. 

3

       •   Point to several 

picture styles to see 

the live previews.   

    •   Choose the     

 Metal Rounded 

Rectangle style 

(bottom row, third 

column).    

 Your screen should be similar to  

Figure 1.65
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 Rehearsing a Presentation PP1.61

Border color changed 

to Blue, Accent 2

Beveled Oval, Black 

style applied

Shadow effect removed

  Figure 1.66    

 The addition of a customized graphic image gives your presentation a more 
polished look. Now that the slides are in the order you want and formatted, you 
would like to see how the presentation will look when viewed by an audience.    

  Rehearsing a Presentation 

  Rather than projecting the presentation on a large screen as you would to 
present it for an audience, a simple way to rehearse a presentation is to view it 
on your computer screen as a    slide show.    A slide show displays each slide full 
screen and in order. While the slide show is running during this rehearsal, you 
can plan what you will say while each slide is displayed.  

   USING SLIDE SHOW VIEW 

 When you view a slide show, each slide fills the screen, hiding the PowerPoint 
application window, so you can view the slides as your audience would. You 
will begin the slide show starting with the first slide. 

4

       •   Choose the     

 Beveled Oval, Black 

style in the Picture 

Styles gallery.   

    •   Click  

   

 in the Picture Styles 

group.   

    •   Choose Blue, Accent 

2 from the Theme 

Colors group.   

    •   Click  

   

 in the Picture Styles 

group.   

    •   From the Shadow 

group, choose No 

Shadow.   

    •   Click outside the 

graphic to deselect 

the object.    

  Your screen should be similar to  

  Figure 1.66   
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       •   Select slide 1 in the 

Slides tab.   

    •   Click      Slide Show 

(in the status bar).        

 Your screen should be similar to  

Figure 1.67

 Additional Information 

Using    Slide Show runs the slide 

show beginning with the currently 
selected slide.

  Another Method 

 You also can use    or    on 

the Slide Show tab or the shortcut keys 
 5  and  s   +   5 , respectively, to 
start the slide show.  

PP1.62 Lab 1: Creating a Presentation

First slide of the presentation 

displayed full screen

  Figure 1.67    

 The presentation title slide is displayed full screen, as it will appear when pro-
jected on a screen using computer projection equipment. The easiest way to 
see the next slide is to click the mouse button. You also can use the keys shown 
below to move to the next or previous slide. 

Next Slide Previous Slide

z B

e

S A

Z W

Y U

N (for Next) P (for Previous)

 You also can select Next, Previous, or Last Viewed from the shortcut menu. 
Additionally, moving the mouse pointer to the lower-left corner of the window 
in Slide Show displays the Slide Show toolbar. Clicking    or    moves to the 

previous or next slide, and    opens the shortcut menu. 
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 Having Trouble? 

Refer to the section “Specifying 
Document Properties” in the 
Introduction to Microsoft Office 2010 to 
review this feature.

2

       •   Click to display the 

next slide.   

    •   Using each of the 

methods described, 

slowly display the 

entire presentation.   

    •   When the last slide 

displays a black 

window, click again 

to end the slide show.        

 Your screen should be similar to  

Figure 1.68

 Additional Information 

You can press  q  or use End Show on 
the shortcut menu at any time to end 
the slide show.

 Documenting a File PP1.63

  Figure 1.68    

 After the last slide is displayed, the program returns to the view you were last 
using, in this case, Normal view.    

  Documenting a File 

  Finally, you want to update the presentation file properties by adding your 
name as the author, and a tag. The default title does not need to be changed.     
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  Having Trouble? 

 Refer to the section “Printing a 
Document” in the Introduction to 
Microsoft Office 2010 to review basic 
printing features.  

PP1.64 Lab 1: Creating a Presentation

Document properties

  Figure 1.69    

  Previewing and Printing the Presentation 

  Although you still plan to make many changes to the presentation, you want 
to provide a printed copy of the presentation to the foundation director to get 
feedback regarding the content and layout.  

   PRINTING A SLIDE 

 Although your presentation looks good on your screen, it may not look good 
when printed. Shading, patterns, and backgrounds that look good on the 
screen can make your printed output unreadable. Fortunately, PowerPoint 
displays a preview of how your printed output will appear as you specify the 
print settings. This allows you to make changes to the print settings before 
printing and reduces unnecessary paper waste. 

1

       •   Return to Normal 

view and display 

slide 1, if necessary.   

    •   Open the File tab and, 

if necessary, choose 

Info.   

    •   In the Tags text box, 

enter   Volunteer, 
Recruit   

    •   In the Author text 

box, enter   your 
name   

    •   Click anywhere 

outside the text box.    

 Your screen should be similar to  

Figure 1.69

ole31346_PPLab1_001-090.indd   PP1.64ole31346_PPLab1_001-090.indd   PP1.64 9/3/10   10:56 PM9/3/10   10:56 PM



Confirming Pages

  Additional Information 

 Use grayscale when your slides include 
patterns whose colors you want to 
appear in shades of gray.  

 Previewing and Printing the Presentation PP1.65

Print options Preview shows how 

the slide will appear 

when printed

Previous Page button Next Page button

Page scroll box

  Figure 1.70    

 The Print window displays the print options in the left pane that are used to 
modify the default print settings. The preview area displays the first slide in 
the presentation as it will appear when printed using the current settings. It 
appears in color if your selected printer is a color printer; otherwise, it appears 
in grayscale (shades of gray). Even if you have a color printer, you can print 
the slides in grayscale or pure black and white. You want to print using the 
black and white option. The page scroll box shows the page number of the 
page you are currently viewing and the number of total pages. The scroll but-
tons on either side are used to scroll to the next and previous page. 

 The other change you want to make to the print settings is to only print the 
first slide in the presentation. To do this, you will change the settings to print 
the current slide only. 

1

       •   From the File tab 

choose Print.    

  Your screen should be similar to  

  Figure 1.70   
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       •   If you need to select a 

different printer, open 

the Printer drop-down 

list and select the 

appropriate printer.   

    •   Click     

 in the Settings group.   

    •   Choose Pure Black 

and White.   

    •   Click  

   

 in the Settings area.   

    •   Choose Print Current 

Slide from the 

submenu.    

 Your screen should be similar to  

Figure 1.71

  Another Method 

 You could also type  1  in the Slides text 
box to select only the title slide.  

3

      •   If necessary, make 

sure your printer is 

on and ready to print.   

  •   Click     Print.

  Additional Information 
 You will learn about notes in Lab 2.  

  Additional Information 
    Please consult your instructor for 
printing procedures that may differ from 
the following directions.           

PP1.66 Lab 1: Creating a Presentation

Changes

which slides

print

Print Preview displays 

slides in black and white

Prints using specified 

settings

Changes printer

Changes color 

settings

Shows number of 

slides that will print

  Figure 1.71    

 The preview area displays how the slide will look when printed in black and 
white. Notice the page scroll box in the preview area now show 1 of 1, indicat-
ing that only the first slide will be printed. 

 A printing progress bar appears in the status bar, indicating that the program 
is sending data to the printer and the title slide should be printing.  

  PRINTING HANDOUTS 

 You also can change the type of printed output from full page slides to any one 
of the output settings described in the table below. Only one type of output can 
be printed at a time. 

Output Type Description

Full Page Slides Prints one slide on a page.

Notes Pages Prints the slide and the associated notes on a page.

Outline Prints the slide content as it appears in Outline view.

Handouts Prints multiple slides on a page.
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 Additional Information 

The Orientation setting will override 
the Slide Layout setting. So, even if 
you leave the Slide Layout setting 
as 6 Slides Vertical, the presentation 
will print horizontal to match the 
Orientation setting.

 Previewing and Printing the Presentation PP1.67

 To help the foundation’s director get a better feel for the flow of the presenta-
tion, you decide to also print out the presentation as a handout. The handout 
format will allow him to see each slide as it appears onscreen. 

Specifies type 

of output

Preview of handout 

with six slides per page

Vertical layout 

displays slides down

a row then across

  Figure 1.72    

 The preview area shows the handouts as they will print. The vertical arrange-
ment of the slides displays the slides down a row and then across. You decide 
to change the orientation from the default of portrait to landscape so that the 
slides print across the length of the paper, to change the arrangement to hori-
zontal, and also to increase the number of slides per page so that the entire 
presentation fits on one page. 

1

       •   Open the File menu 

and choose Print.   

    •   Click  

 
 in the Settings area 

and choose Print All 

Slides.   

    •   Click  

   

 in the Settings area 

and choose .   

   Your screen should be similar to  

  Figure 1.72   
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PP1.68 Lab 1: Creating a Presentation

Changes

orientation

Preview of handout 

with 9 slides per page in

landscape orientation

Horizontal layout 

displays slides across

a row then down

  Figure 1.73    

 The preview area reflects your changes to the print settings. The horizontal 
layout displays the slides in order across a row and then down, making the 
presentation easier to follow. 

 Your printed output should be similar to that shown in the Case Study at the 
beginning of the lab.  

  PRINTING AN OUTLINE 

 The final item you want to print is an outline of the presentation. An outline 
will make it easier for the director to provide feedback on the overall organiza-
tion of the presentation.       

2

     •   Change the Color 

setting to Pure 

Black and White, if 

necessary.   

    •   Click      and 

choose 9 Slides 

Horizontal.   

    •   Click  

 and choose Landscape 

Orientation.    

 Your screen should be similar to  

Figure 1.73

3

       •   Click      Print.    
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  Another Method 

 You also can exit PowerPoint 
using     in the File tab.  

 Exiting PowerPoint PP1.69

 The printed outline will be a two-page document that looks similar to the 
preview.    

  Exiting PowerPoint 

  You have finished working on the presentation for now and will exit the Pow-
erPoint program.       

1

      •   Open the File tab and choose Print.   

    •   Change the Color setting to Pure Black and White again, if necessary.   

    •   Change the orientation to Portrait Orientation.   

    •   Click      and choose .   

  •   Ensure that the correct printer is selected and ready and click    .

1

      •   Click      Close in the 

title bar.   

  •   If asked to save 

the file again, click  

  .

 EXPLORE YOUR CAREER OPTIONS 

  Account Executive 
 Sales is an excellent entry point for a solid career in any com-

pany. Account executive is just one of many titles that a sales 

professional may have; field sales and sales representative are 

two other titles. Account executives take care of customers by 

educating them on the company’s latest products, designing 

solutions using the company’s product line, and closing the 

deal to make the sale and earn their commission. These tasks 

require the use of effective PowerPoint presentations that edu-

cate and motivate potential customers. The salary range of 

an account executive is limited only by his or her ambition; 

salaries range from $30,000 to more than $120,540. To learn 

more about this career, visit the Web site for the Bureau of 

Labor Statistics of the U.S. Department of Labor.       

      FOCUS ON CAREERS 
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PP1.70 Lab 1: Creating a Presentation

 Creating a Presentation Lab 1 CONCEPT SUMMARY 

   Slide (PP1.6)  

 A slide is an individual “page” of 
your presentation.  

   Spelling Checker (PP1.16)

 The spelling checker locates most 
misspelled words, duplicate words, 
and capitalization irregularities as 
you create and edit a presentation, 
and proposes possible corrections.  

   AutoCorrect   (PP1.18)

 The AutoCorrect feature makes 
some basic assumptions about the 
text you are typing and, based on 
those assumptions, automatically 
corrects the entry.  

Spelling checker

Slide
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 Concept Summary PP1.71

   Layout (PP1.42)  
 A layout defines the position 
and format for objects and text 
on a slide. A layout contains 
placeholders for the different items 
such as bulleted text, titles, charts, 
and so on.  

   Graphic   (PP1.54)  
 A graphic is a nontext element 
or object, such as a drawing or 
picture, that can be added to a 
slide.   

Layout

Graphic
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    AutoCorrect PP1.18   
   character formatting PP1.47   
   clip art PP1.54   
   current slide PP1.9   
   custom dictionary PP1.16   
   default settings PP1.5   
   demote PP1.25   
   drawing object PP1.54   
   embedded object PP1.54   
   graphic PP1.54   
   keyword PP1.56   
   layout PP1.42   
   main dictionary PP1.16   
   Notes pane PP1.6   
object PP1.6
   Outline tab PP1.6   
   paragraph formatting PP1.47   
   picture PP1.54   

   picture style PP1.59   
   placeholder PP1.6   
   placeholder text PP1.6   
   promote PP1.26   
   sans serif font PP1.48   
   serif font PP1.47   
   sizing handles PP1.44   
   slide PP1.6   
   Slide indicator PP1.6   
   Slide pane PP1.6   
   slide show PP1.61   
   Slides tab PP1.6   
   source program PP1.54   
   spelling checker PP1.16   
   style PP1.59   
   text effects PP1.50   
   thumbnail PP1.6   
   view PP1.6     

     KEY TERMS 

 Creating a Presentation   LAB REVIEW    Lab 1  
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  COMMAND SUMMARY 

Command Shortcut Action

File tab

Save c + S Saves presentation

= Saves presentation using new file name and/or location

c + O Opens existing presentation

Closes presentation

Info Document properties

New c + N Opens New Presentation dialog box

Print c + P Opens print settings and a preview pane

Closes PowerPoint

Quick Access Toolbar

 Save c + S Saves presentation

 Undo c + Z Reverses last action

Home tab

Clipboard group

c + V Pastes item from Clipboard

 Cut c + X Cuts selection to Clipboard

 Copy c + C Copies selection to Clipboard

Slides group

c + M Inserts new slide with selected layout

Changes layout of a slide

Font group

 Font Changes font type

 Size Changes font size
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LAB REVIEW

COMMAND SUMMARY (CONTINUED)

Command Shortcut Action

Increases font size

Decreases font size

Italicizes text

Underlines text

Applies a shadow effect

Changes font color

Paragraph group

 Bullets/Bullets Formats bulleted list

 Numbering/Bulleted Formats numbered lists

Editing group

 / c + A Selects everything in the placeholder box

Insert tab

Illustrations group

Inserts clip art

Slide Show tab

Start Slide Show group

5 Displays presentation starting with the first slide

s + 5 Displays presentation starting with the current slide

Review tab

Proofing group

7 Spell-checks presentation
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COMMAND SUMMARY (CONTINUED)

Command Shortcut Action

View tab

Presentation Views group

Switches to Normal view

Switches to Slide Sorter view

Picture Tools Format tab

Adjust group

Modifies the color of the picture

Picture Styles group

 More
Opens Picture styles gallery to choose an overall visual 
style for a picture

Changes layout of a drawing

Applies a border style to picture

Applies a visual effect to picture
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  SCREEN IDENTIFICATION 
    1. In the following PowerPoint screen, letters identify important elements. Enter the correct term for 

each screen element in the space provided. 

  LAB EXERCISES 

Clip art
Object
Picture Styles
Slide Show view
Slide pane
Slide title
Current slide

Presentation template
Outline tab
Sizing handle
Slides tab
Note pane
Thumbnail

      A.      ___________________
     B.      ___________________
      C.      ___________________
      E.      ___________________
         F.      ___________________
    G.      ___________________

  H.      ___________________
               I.      __________________
             J.      __________________
      K.      __________________
         L.      __________________
  M.    __________________

     Possible answers for the screen identification are:

A

B M CD

E

F

G

H

I

J

K

L
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  MATCHING 
 Match the item on the left with the correct description on the right. 

____  a. small image  

____  b. sample text that suggests the content for the slide  

____  c. moves the slide back to the previous slide in a presentation  

____  d. individual page of a presentation  

____  e. displays each slide as a thumbnail  

____ f. indents a bulleted point to the right  

____  g. defines the position and format for objects and text that will be 
added to a slide  

____  h. includes space to enter notes that apply to the current slide  

____ i. becomes part of the presentation file and can be opened and 
edited using the source program  

____ j. tool that automatically resizes text to fit within the placeholder    

    1. AutoFit     

   2. demote     

   3. embedded object     

   4. Previous Slide button     

   5. layout     

   6. Notes pane     

   7. placeholder text     

   8. slide     

   9. Slides tab     

   10. thumbnail      

  TRUE/FALSE 
 Circle the correct answer to the following questions. 

 1. A layout contains placeholders for different items such as bulleted text, 
titles, and charts. True False

 2. PowerPoint will continue to indent to the same level when you demote 
a bulleted point until you cancel the indent. True False

 3. A slide is a set of characters with a specific design. True False

 4. PowerPoint identifies a word as misspelled by underlining it with 
a wavy blue line. True False

 5. PowerPoint can print multiple types of output at a time. True False

 6. The Previous Slide and Next Slide buttons are located at the bottom 
of the horizontal scroll bar. True False

 7. Content templates focus on the design of a presentation. True False

 8. Graphics are objects, such as charts, drawings, pictures, and scanned 
photographs, that provide visual interest or clarify data. True False

 9. You can rely on AutoCorrect to ensure your document is error free. True False

 10. After the final slide is displayed in Slide Sorter view, the program will 
return to the view you were last using. True False 
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  FILL-IN 
 Complete the following statements by fi lling in the blanks with the correct terms. 

    1. __________________   is a set of picture files or simple drawings that comes with Office 2010.  

   2. The size of a __________________   can be changed by dragging its sizing handles.  

   3. A   __________________ is an individual “page” of your presentation.  

   4. __________________   define the position and format for objects and text that will be added to a 
slide.  

   5. A   __________________ is text or graphics that appears at the bottom of each slide.  

   6. When selected, a placeholder is surrounded with eight __________________  .  

   7. A __________________    is a miniature of a slide.  

   8. __________________   is a PowerPoint feature that advises you of misspelled words as you add text 
to a slide and proposes possible corrections.  

   9. A   __________________ is a file containing predefined settings that can be used as a pattern to cre-
ate many common types of presentations.  

   10. An embedded object is edited using the __________________   program.    

  MULTIPLE CHOICE 
 Circle the correct response to the questions below. 

    1. The step in the development of a presentation that focuses on determining the length of your 
speech, the audience, the layout of the room, and the type of audiovisual equipment available is 
  __________________. 
    a. editing  
   b. creating  
   c. planning  
   d. enhancing    

   2. A   __________________ is a file containing predefined settings that can be used as a pattern to cre-
ate many common types of presentations. 
    a. presentation  
   b. slide  
   c. template  
   d. graphic    

   3. The __________________   feature makes some basic assumptions about the text you are typing and, 
based on those assumptions, automatically corrects the entry. 
    a. grammar checker  
   b. AutoCorrect  
   c. spelling checker  
   d. template    

LAB EXERCISES
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   4. If you want to work on all aspects of your presentation, switch to   __________________ view, which 
displays the Slide pane, Outline pane, and Notes pane. 
    a. Normal  
   b. Outline  
   c. Slide  
   d. Slide Sorter    

   5.   __________________ displays a miniature of each slide to make it easy to reorder slides, add special 
effects such as transitions, and set timing between slides. 
    a. Slide Show view  
   b. Normal view  
   c. Reading view  
   d. Slide Sorter view    

   6. If you want to provide copies of your presentation to the audience showing multiple slides on a 
page, you would print __________________  . 
    a. note pages  
   b. slides  
   c. handouts  
   d. outline area    

   7. A(n) __________________   is an onscreen display of your presentation. 
    a. slide  
   b. handout  
   c. outline  
   d. slide show    

   8. A   __________________ is a nontext element or object, such as a drawing or picture, that can be 
added to a slide. 
    a. slide  
   b. template  
   c. text box  
   d. graphic    

   9. When the spelling checker is used, you can create a(n)   __________________ dictionary to hold 
words that you commonly use but are not included in the main dictionary. 
    a. official  
   b. common  
   c. personal  
   d. custom    

   10. The keyboard shortcut to view a slide show is   __________________. 
    a.  5   
   b.  a   +  V  
   c.  3   
   d.  c   +  V       

ole31346_PPLab1_001-090.indd   PP1.79ole31346_PPLab1_001-090.indd   PP1.79 9/3/10   10:56 PM9/3/10   10:56 PM



Confirming Pages

WWW.MHHE.COM/OLEARY

PowerPoint 2010

PP1.80 Lab 1: Creating a Presentation

  TRIPLE CROWN PRESENTATION È 

    1. Logan Thomas works at Adventure Travel Tours. He is working on a presentation about lightweight 
hiking to be presented to a group of interested clients. Logan recently found some new information 
to add to the presentation. He also wants to rearrange some slides and make a few other changes to 
improve the appearance of the presentation. The handouts of your completed presentation will be 
similar to those shown here. 

    a. Open the file pp01_Triple Crown. Run the slide show.  

   b. Enter your name in the subtitle on slide 1.  

   c. Spell-check the presentation, making the appropriate corrections.  

   d. Change the layout of slide 5 to Title Only.  

   e. Move slide 6 before slide 5.  

   f. Insert an appropriate photograph from the Clip Art gallery on slide 4. Size and position it 
appropriately.  

   g. Insert a new slide using the Two Content layout after slide 4.  

  STEP-BY-STEP 

 Hands-On Exercises               LAB EXERCISES 
RATING SYSTEM

È Easy

ÈÈ Moderate

ÈÈÈ Difficult
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   h. Enter the title  Less is More.  Insert an appropriate photograph on hiking from the Clip Art gallery 
in the right content placeholder. Move to slide 4 and select the second promoted bullet, “Where to 
cut weight:”, and its subpoints. Cut this text and paste it in the left content placeholder of slide 5.  

   i. Change the layout of slide 7 to Title and Content layout. Add the following text in the text place-
holder:  Contact Steve Johnson at Adventure Travel Tours or visit us on the Web at    www.
AdventureTravelTours.com/hiking  .  

   j. Run the slide show.  

   k. Save the presentation as Triple Crown Presentation. Print the slides in landscape orientation as 
handouts (four per page).            

  EMERGENCY DRIVING TECHNIQUES ÈÈ 

    2. The Department of Public Safety holds monthly community outreach programs. Next month’s 
topic is about how to handle special driving circumstances, such as driving in rain or snow. You are 
responsible for presenting the section on how to handle tire blowouts. You have organized the top-
ics to be presented and located several clip art graphics that will complement the talk. Now you are 
ready to begin creating the presentation. Handouts of the completed presentation are shown here. 

ole31346_PPLab1_001-090.indd   PP1.81ole31346_PPLab1_001-090.indd   PP1.81 9/3/10   10:56 PM9/3/10   10:56 PM



Confirming Pages

WWW.MHHE.COM/OLEARY

PowerPoint 2010

PP1.82 Lab 1: Creating a Presentation

    a. Open the PowerPoint presentation pp01_Handling Blowouts.  

   b. Run the spelling checker and correct any errors.  

   c. On slide 1, replace “Student Name” with your name. 

 Increase the title text to 54 pts. 

 Change title text color to Dark Red, Accent 1, Darker 50%.  

   d. On slide 5: 

   Promote bullet 4. 

   Demote the last bullet. 

   AutoFit the content text to the placeholder  

     e. On slide 6, insert a clip art image on the theme of tires and position it in the lower-right corner 
of the slide.  

         f. On slide 3, change the color of the clip art to Dark Red, Accent 6, Light. Apply the Bevel Rect-
angle picture style to the clip art image.  

   g. Save the presentation as Handling Blowouts.  

   h. Run the slide show.  

          i. Print the slides as handouts (six per page, horizontal) and close the presentation.          

  WRITING EFFECTIVE RESUMES ÈÈ 

    3. You work for the career services center of a major university and are working on a presentation to 
help students create effective resumes and cover letters. You are close to finishing the presentation 
but need to clean it up and enhance it a bit before presenting it. The handouts of your completed 
presentation will be similar to those shown here. 

    a. Open the PowerPoint presentation pp01_Resume.  

   b. Run the spelling checker and correct any spelling errors.  

   c. On slide 1: Display in normal view. 

   Change title font size to 54 pt. Use the AutoFit option to fit the text into the placeholder. 

   Change subtitle font size to 20 pt. 

   Search the Clip Art gallery on the theme of success. Insert, size, and position an appropriate graphic. 

   Apply an appropriate picture style to the selected graphic and change its color.  

   d. On slide 2, replace “Student Name” with your name. Use picture styles and effects to improve the 
appearance of the picture.  

   e. On slides 3 and 4, search the Clip Art gallery on the theme of success. Insert, size, and position an 
appropriate graphic on each slide. Apply an appropriate picture styles to the graphics and change 
their colors.  

   f. On slide 5, capitalize the first word of each bulleted item.  

   g. On slide 6, split the slide content into two slides. Move the first bulleted item on the new slide (7) 
back to slide 6 so slide 7 begins with the “Other” bulleted item. Appropriately adjust the bullet 
level and font size of the moved item on slide 6.  

   h. On slide 10, reorganize the bulleted items so “Types of cover letters” is the first item.  

LAB EXERCISES
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   i. To match the slide order with the way the topics are now introduced, move slide 13 before 
slide 11.  

   j. On slide 13: Break each bulleted item into two or three bullets each as appropriate. 

   Capitalize the first word of each bulleted item. 

   Remove any commas and periods at the end of the bullets.  

   k. Save the presentation as Resume1.  

   l. Run the slide show.  

   m. Print the slides as handouts (nine per page, horizontal, in landscape orientation) and close the 
presentation.            
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  EMPLOYEE ORIENTATION ÈÈÈ 

    4. As the front desk manager of the Essex Inn, you want to make a presentation to your new employ-
ees about all of the amenities your hotel offers its guests as well as information on activities and 
dining in the area. The purpose of this presentation is to enable employees to answer the many 
questions that are asked by the guests about both the hotel and the town. The handouts of your 
completed presentation will be similar to those shown here. 

LAB EXERCISES

     a. Open pp01_Essex Inn, which uses the Opulent content template from Microsoft Online.  

   b. On slide 1: 

 Enter  Essex Inn  as the company name. Set the font to Constantia; apply Bold and Shadow. 
Change the font color to Ice Blue, Background 2, and size 66. 

 Insert, size, and position a clip art image suitable as a hotel logo in place of the “your logo here” 
graphic. 

 Insert a line after the title. Type your name on the line, and change the font size to Trebuchet MS 
and the font size to 20. Change the font color to White and apply italics.  
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   c. On slide 2: 

 Enter  Amenities and Activities for Guests  as the title. 

Change the font size of the title to 31.

 Enter the sample bulleted text  What is there to do?  as the first bullet. 

 Enter  At the hotel or in the town?  as the second bullet. 

 Remove the remaining bulleted items.  

   d. Insert a new slide after slide 2. In this slide: 

 Set the layout to Title and Content. 

 Enter  Hotel Amenities and Activities  as the title. 

 Enter  Dining  as the first bullet. 

 Enter  Activities  as the second bullet. 

 Enter  Other amenities  as the third bullet. 

 Insert, size, and position a clip art image suitable for a hotel at the bottom center of the slide. 
Apply picture styles and effects.  

    e. Insert a new slide after slide 3. In this slide: 

 Set the layout to Title and Content. 

 Enter  Dining  as the title. 

 Enter  Breakfast  as the first bullet under Dining. 

 Enter  Eggs Benedict or custom omelet  and demote to appear as the first bullet under Breakfast. 

 Enter  Daily chef’s special  as the second bullet under Breakfast. 

 Enter  Lunch  and promote to appear as the second bullet under Dining. 

 Enter  Custom-pack lunch for outings  and demote to appear as the first bullet under Lunch. 

 Enter  Build-your-own sandwich bar  as the second bullet under Lunch. 

 Enter  Dinner  and promote to appear as the third bullet under Dining. 

 Enter  Four course meal (salad, soup, entrée, dessert)  as the first bullet under Dinner. 

 Enter  Three nightly chef specials  as the second bullet under Dinner.  

   f. Insert a new slide after slide 4. In this slide: 

 Set the layout to Title and Content. 

 Enter  Activities  as the title. 

 Enter  Morning  as the first bullet under Activities. 

 Enter  Bird watching on the veranda  and demote to appear as the first bullet under Morning. 

 Enter  Lecture/Tour of gardens and hotel  as the second bullet under Morning. 

 Enter  Afternoon  and promote to appear as the second bullet under Activities. 

 Enter  Daily guest lecture or class  as the first bullet under Afternoon. 

 Enter  Historic walking tour of downtown  as the second bullet under Afternoon. 

 Enter  Evening  and promote to appear as the third bullet under Activities. 

 Enter  Champagne meet/greet  and demote to appear as the first bullet under Evening. 

 Enter  Live music/dancing with dinner  as the second bullet under Evening.  
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LAB EXERCISES

   g. Insert a new slide after slide 5. In this slide: 

 Set the layout to Title and Content. 

 Enter  Other Amenities  as the title. 

 Enter  Special dining events  as the first bullet under Other Amenities. 

 Enter  Sunday champagne brunch  and demote to appear as the first bullet under Special Dining 
Events. 

 Enter  Saturday afternoon tea  as the second bullet under Special Dining Events. 

 Enter  Extras  and promote to appear as the second bullet for Other Amenities. 

 Enter  Third Tuesday cooking class  and demote to appear as the first bullet under Extras. 

 Enter  Tour of haunted houses on Saturdays at nine  as the second bullet under Extras. 

 Insert, size, and position a clip art image suitable for a hotel at the bottom center of the slide. 
Apply picture styles and effects.  

   h. Delete slides 7 through 13.  

       i. On the Summary slide 7. 

 Enter  Hotel amenities and activities  as the first bullet under Summary. 

 Enter  Dining  and demote to appear as the first bullet under Hotel amenities and activities. 

 Enter  Activities  as the second bullet under Hotel amenities and activities. 

 Enter  Other amenities  as the third bullet under Hotel amenities and activities. 

 Enter  Always remember  and promote to appear as the second bullet under Summary. 

 Enter  Our guests are our customers  and demote to appear as the first bullet under Always 
remember. 

 Enter  Treat our guests as friends  as the second bullet under Always remember. 

 Enter  Thanks for attending and put these ideas into practice  and promote to appear as the 
third bullet under Summary. 

 Delete any remaining bullet placeholders.  

     j. Save the presentation as Essex Inn Orientation.  

   k. Run the slide show.  

         l. Print the slides as handouts (four per page, horizontal, in landscape orientation).            

  WORKPLACE ISSUES ÈÈÈ 

    5. Tim is preparing for his lecture on “Workplace Issues” for his Introduction to Computers class. 
He uses PowerPoint to create presentations for each of his lectures. He has organized the topics 
to be presented, and located several clip art graphics that will complement the lecture. He is now 
ready to begin creating the presentation. Several slides of the completed presentation are shown 
here. 
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    a. Open a new presentation using the Staff Training Presentation template. If you don’t have access 
to the Internet, you can use the file pp01_Staff Training.  

   b. On slide 1: 

 Change the title to  Workplace Issues.  Change the font size to 48 and apply a bold effect. 

 Change the subtitle text to  Lecture 4.  

 Add a line beneath the subtitle and type  Presented by Your Name.  Change the font size of this 
line to 24. 

 Insert, size, and position a clip art image suitable for the theme of an office meeting. Apply a pic-
ture style to the image.  

     c. On slide 2: 

 Enter  Topics of Discus-
sion  as the title text. 

 Enter  Ergonomics  as 
 bullet 1. 

 Enter  Ethics  as bullet 2. 

 Enter  Environment  as 
bullet 3.  
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   d. On slide 3: 

 Enter  Ergonomics  as the title. 

 Enter  Definition  as the first bullet. 

 Enter  Fit the job to the worker rather than forcing the worker to contort to fit the job  as the sec-
ond bullet. 

 Enter  The study of human factors related to computers  as the third bullet.  

     e. Change the order of bullets 2 and 3 on slide 3. 

 Demote bullets 2 and 3.  

      f. On slide 4: 

 Change the title to  Mental Health.  

 Include two bulleted items:  Noise  and  Monitoring.   

         g. Change the title of slide 5 to  Physical Health  and include the following bulleted items: 

 Bullet 1:  Eyestrain and headache  

 Bullet 2:  Back and neck pain  

 Bullet 3:  Electromagnetic fields  

 Bullet 4:  Repetitive strain injury  

 Insert, size, and position a suitable clip art image. Use the picture formatting tools to customize 
the image to suit the presentation.  

    h. On slide 6: 

 Change the title to  Ethics.  

 Include two bullets:  Definition  and  Guidelines for the morally acceptable use of computers in 
our society.  

 Demote bullet 2.  

     i. Change the title of slide 7 to  Primary Ethical Issues.  

 Enter  Privacy  as bullet 1. 

 Enter  Accuracy  as bullet 2. 

 Enter  Property  as bullet 3. 

 Enter  Access  as bullet 4. 

 Insert, size, and position a suitable clip art image. Use the picture formatting tools to customize 
the image to suit the presentation.  

         j. Insert a new Two Content layout slide between slides 7 and 8. On the new slide 8: 

 Enter  The Environment  as the title. 

 Enter  The Energy Star Program  as the first bullet. 

 Enter  The Green PC  as the second bullet. 

 In the right placeholder, insert, size, and position a suitable clip art image. Use the picture for-
matting tools to customize the image to suit the presentation.  

LAB EXERCISES
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         k.  Create a duplicate of slide 8. On the new slide 9: 

  Enter  The Green PC  as the title. 

  Enter  System Unit  as the first bullet. 

  Enter  Display  as the second bullet. 

  Enter  Manufacturing  as the third bullet. 

  In the right placeholder, insert, size, and position an appropriate clip art image.  

   l.  On slide 10: 

  Enter  Personal Responsibility  as the title. 

  Enter  Conserving  as the first bullet. 

  Enter  Recycling  as the second bullet. 

  Enter  Educating  as the third bullet.  

   m. In Slide Sorter view, move slide 5 before slide 4.  

     n.     Change the font of the words “Lecture 4” in the subtitle on the title slide to Times New Roman 
and the size to 44 pt.  

     o. Save the presentation as Workplace Issues.  

   p.  Run the slide show. Revised PowerPoint_2010_Brief_Solutions  

     q. Print the slides as handouts (six per page in landscape orientation).             

  ON YOUR OWN 

  INTERNET POLICY PRESENTATION È 

    1. You are working in the information technology department at International Sales Incorporated. 
Your manager has asked you to give a presentation on the corporation’s Internet policy to the new-
hire orientation class. Create your presentation with PowerPoint, using the information in the 
Word file pp01_Internet Policy as a resource. Use a template of your choice. When you are done, run 
the spelling checker, then save your presentation as Internet Policy and print it.    

  TELEPHONE TRAINING COURSE ÈÈ 

    2. You are a trainer with Super Software, Inc. You received a memo from your manager alerting you 
that many of the support personnel are not using proper telephone protocol or obtaining the proper 
information from customers who call in. Your manager has asked you to conduct a training class that 
covers these topics. Using the Word document pp01_Memo data file as a resource, prepare the slides 
for your class. When you are done, save the presentation as Phone Etiquette and print the handouts.    
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LAB EXERCISES

  VISUAL AIDS ÈÈ 

    3. You are a trainer with Super Software, Inc. Your manager has asked you to prepare a presentation 
on various visual aids that may be used in presentations. Using the pp01_VisualAids data file as a 
resource, create an onscreen presentation using an appropriate template. Add clip art that illus-
trates the type of visual aid. Include your name on the title slide. When you are done, save the pre-
sentation as Presentation Aids and print the handouts.    

  WEB DESIGN PROPOSAL ÈÈÈ 

    4. Your company wants to create a Web site, but it is not sure whether to design its own or hire a Web 
design firm to do it. You have been asked to create a presentation to management relaying the pros 
and cons of each approach. To gather information, search the Web for the topic “Web design,” and 
select some key points about designing a Web page from one of the “how-to” or “tips” categories. 
Use these points to create the first part of your presentation, and call it something like “Creat-
ing Our Own Web Page.” Then search the Web for the topic “Web designers,” and select two Web 
design firms. Pick some key points about each firm (for example, Web sites they have designed, 
design elements they typically use, and/or their design philosophy). Finally, include at least one 
slide that lists the pros and cons of each approach. Include your name on the title slide. When your 
presentation is complete, save it as Web Design and print the slides as handouts. 

   You will expand on this presentation in On Your Own Exercise 4 of Lab 2.    

  CAREERS WITH ANIMALS ÈÈÈ 

    5. You have been volunteering at the Animal Rescue Foundation. The director has asked you to pre-
pare a presentation on careers with animals to present to local schools in hopes that some students 
will be inspired to volunteer at the foundation. Using the Word document pp01_Animal Careers 
data file as a resource, create the presentation. Add photos or clip art where appropriate. When you 
are done, save the presentation as Careers with Animals and print the handouts.        
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